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Copyright

Copyright 2022 by BenQ Corporation. All rights reserved. No part of this publication may be
reproduced, transmitted, transcribed, stored in a retrieval system or translated into any language or
computer language, in any form or by any means, electronic, mechanical, magnetic, optical, chemical,
manual or otherwise, without the prior written permission of BenQ Corporation.

All other logos, products, or company names mentioned in this manual may be the registered
trademarks or copyrights of their respective companies, and are used for informational purposes
only.

Disclaimer

BenQ Corporation makes no representations or warranties, either expressed or implied, with
respect to the contents hereof and specifically disclaims any warranties, merchantability or fitness for
any particular purpose. Further;, BenQ Corporation reserves the right to revise this publication and
to make changes from time to time in the contents hereof without obligation of BenQ Corporation
to notify any person of such revision or changes.

This user manual aims to provide the most updated and accurate information to customers, and thus
all contents may be modified from time to time without prior notice. Please visit http://business-
display.beng.com/ for the latest version of this manual.


http://business-display.benq.com/
http://business-display.benq.com/
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BenQ X-Sign

Created to help users of BenQ interactive flat panels and digital signages to better utilize their
equipment, BenQ X-Sign includes BenQ X-Sign Designer for content creation and standalone mode
schedule setting. BenQ X-Sign also includes BenQ X-Sign Manager and BenQ X-Sign Player for cloud-
based content management and distribution, to show X-Sign Player in single or group displays.

Basic

Account
Registering an account for X-Sign Manager (Admin)

Watch demonstration video:

With BenQ |AM (Identify and Access Management), you can manage all of your BenQ services
(including X-Sign Manager) in one account. Follow the steps below to register an account and
connect to X-Sign Manager.

I. Go to BenQ Service website https://service-portal.benqg.com/login. Suggested browsers are
Chrome, Firefox.

2. If you are an administrator, click Register(Admins only) to register an Administrator account
for the company.

English

Welcome to BenQ Service

Login your account

| Keep me signed in Forget ID / password?
Resend verification email

Register(Admins only)

v1.5.3.1 Suggested browsers: Chrome,Firefox

Note: If you are a regular user, ask your company’s administrator to create a user account for you.
After you receive the account, click Log in directly after verifying your email.

BenQ X-Sign 5


https://service-portal.benq.com/login

Message

The email has not been verified. We'll send the email from "BenQ", so you
can quickly search for it. If it isn't in your inbox, check your folders. If a spam
filter or email rule moved the email, it might be in the Spam, Junk, Trash,

Deleted Items, or Archive folder.

3. After you click Register(Admins only), you will see the following message. Go to Click here
to proceed.

Message

To create an administrator account,|click here.

To create a user account, contact your administrator.

Exit

4. Fill in the following fields and click Submit to create a new Administrator account.

Sign up
*E-mail
D Use email as account ID
*Account 1D
REMIND: Please do NOT using your personal
data to fill the account name. It may increase the
risk to reveal you privacy.
*Password

Cancel
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Note:

* For the account ID, enter a value between 4 and 20 characters long. Only numbers (0-9), upper
and lowercase alphabets (A-Z, a-z), and the following special characters (-)(.)(_) are allowed in the
account ID and name.

* The password must be a combination of alphanumeric and must be between 6-12 characters.
Passwords like “2945678” (all numbers), “eduabsc” (all alphabets), “12ab” (less than 6 characters),
and “12abcd345678efg” (more than |12 characters) are unacceptable.

* Uppercase and lowercase letters don’t need to be typed the same way every time you key in the
password.

Accessing your account

Two ways are provided to access your account:

I. Go to BenQ Service website https://service-portal.benq.com/login. Log in and choose X-Sign.

English

Welcome to BenQ Service

Login your account

Account ID or Email

Password ©

[:l Keep me signed in Forget ID / password?
Resend verification email

Register(Admins only)

v1.5.3.1 Suggested browsers: Chrome, Firefox

n BenQ Service Portal 2 genQ  [Progow

Your Service

= IAM ); X-Sign D DMS >

We provide
- e
;) B 2
g X >
IAM X-Sign DMS

BenQ X-Sign


https://service-portal.benq.com/login

2. Go to BenQ display website https://x-sign.beng.com/. Click Login to go to the X-Sign Manager
page.

BeéNnQ oispLay Explore Get Inspired Find Product Get Support

Features  Downloads

‘ cMs Broadcast All devices *
| By Device Add a New Device Add Category X-Sign Player Update Search.
B All devices (1)
By Channel
All devices
> File Management
Stat ~ Name Channel Device ID pack
> Verification us Name
» My Favorite = i Premium
HRSLB23V Unsubscribed HR5LB23V
2022-09-11 10:...

Report Analysis

Advanced Application

License Management

About

Setting the permission for users

I. To set the permission for users, log in and choose IAM.

Your Service

1AM )‘ X-Sign D DMS >

We provide
- —
b
s
; %) | D
IAM X-Sign DMS

8 BenQ X-Sign


https://x-sign.benq.com/

2. Select Role Management > X-Sign, then choose the account you want to set the permission
to. Click % to continue.

n BenQ Identity and Access Management & Albert [

Account Management | Role Management | Agent Setting Service {_- Taiwa

X | A\

X-Sign AMS

of]u ~-

Role &
2 - adede
2 - Admin
& & administrator(Default)
4 - channel_manager(Default)
5. & content_manager(Default)
6. F-3 fagvideo

3. You can set the permission to the account by checking the boxes. Click Submit to proceed.

Edit role settings
Role Name adcde
Permission Device Management Channel Management BDP File Management
View View View
New MNew Upload
Eciit Edit channel Edit
View Interrupt View channel schedule Delete
Edit Interrupt Edit channel schedule Approve
Remote control Instant message
Delete Delete
Manager Report Advanced Applications
Interactive click statistics Queuing system
QR code API Widget

=

BenQ X-Sign 9



Authorizing other users as admins

Watch demonstration video: =5

The administrator can authorize other users to manage X-Sign Manager. Please be noted that there
can only be THREE admins in the same company, i.e. the original admin with two substitute admins.

I. To authorize agents, go to Account Management.

Available space - 99.5 GB 22 AccountManagement 8 BenQ @ language A7

B e | A deices :
By Device Add a New Device Add Category X-Sign Player Update Sedioh.

» B Al devices (17)

By Channel
»  File Management D (RS
. Status v Name Channel Name Device ID pack
*  Verification
> My Favorite 1st floor Howard_0826 6UWU2FNY ool
St 202011-29 11:01:12
L]
> Report Analysis
v201T Howard_0826 FFMHARS7
»  Advanced Application
¥ License Management
V201T2.2 Howard_0826 VZVBKPE2
License List
License Extension - 1
{xsw | ARES3U4K Howard_0826 ARES3U4K
History and Setting h X ‘ -
About
Premium

testqwe teste GRXJDXTQ

2020-08-04 11:05:41

2. Click Create New Account to proceed.

n BenQ Identity and Access Management

Account Management Role Management Agent Setting Service ( beng

Account Management

Status Account ID Name E-mail
@ 1 x sampleAccount sampleName sample@BenQ.com i
Unverified
@ 2 v Active test1234 test 3jdysehzvg80000000000@yopmail.ci
@ 3 Active User_789 User_789 jennyweng3923@gmail.com

Note: If the user already has an account under the original admin, there is no need to create a new account, just select

#  toedit.
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3. Fill in the account information, check the box, and click Submit. You will receive a verification
email. After verifying the email, you have successfully authorized agents.

n BenQ Identity and Access Management

Account Management

Create New Account

Role Management

E-mail

Account ID

Password

Confirm Password

Name

Company

Country/Area

Timezone

Note

[ use email as account ID

REMIND: Please do NOT using your personal data
o fl the account name. It may increase the risk fo
reveal you privacy.

benq
Taiwan
within 150 characters

Agent Setting

Service Setting

Service

I [ Setthis account as subsiiute adminstrator has all of the permissions, two accourts at most |

Enable Service

X xsign

D ows

A s

Role

Schedule Manager

Guest

User

Create a new role

Cancel

BenQ X-Sign



License

Purchasing the license from X-Sign Manager

Watch demonstration video:

You can purchase the license from X-Sign Manager in License Management > License
Extension.

Available space - 99.5 GB 22 AccountManagement & BenQ @ Language A7

cMs. Broadcast ‘ All devices o
By Device Add a New Device Add Category X-Sign Player Update Search, Q
» & All devices (17)

By Channel

»  File Management ) Anreviees
Status ¥ Name Channel Name Device ID pack
¥ Verification
Premium

»

My Favorite i lstfioor Howard_0826 BUWU2FNY HOAG T

»  Report Analysis
V2017 Howard_0826 FFMHARS?
> Advanced Application

¥ License Management
v2.01T2_2 Howard_0826 VZV5KPE2

License List

icense Extension

History and Setting

About -
remium
testqwe teste (CRAAIDXTR 2020-08-04 11:05:41

ARES3U4K Howard_0826 ARES3U4K

Available space - 99.5 GB 22 AccountManagement 8, BenQ @ Language 47

Please Choose Categories :

By Device

By Channel

File Management

Verification

My Favorite

k

Report Analysis

(H)

Advanced Application

“«

License Management
Buy New License Extend My Contract

License List

I License Extension
History and Setting

About

12 BenQ X-Sign



After clicking Buy New License,

I. Choose the quantity of license which you want to purchase. There are two types: Basic and Pre-
mium.

2. Select Add to Shopping Cart.
3. Click the shopping cart icon to access to the checkout page.
Note: If the quantity is more than 20, it is highly suggested that you select More than 20.

Available space - 995 GB 23 Account Management 2, BenQ @ Language 47

Buy New License
By Device

Basic Premium
By Channel
uss149.90 a0 0ss249.9 0 o)
> File Management ; y s
Platform % droid box dowes box (7, 10 x64) BonQ Smart Signage | Androidbox | Windows box (7, 10 x64) |

> Verification !

Content Mangment v v v v v v v v
> My Favorite

Channel Scheduling v v v v v v v v
> Report Analysis

Device Cortrol v 5%
> Advanced Application
Xsign Player Remote Upgrade v v v v
> License Management
Vo wal o v A i
About
System Report o v v v Vg v v v
Interactive Function v v v v
Touch Usage Report v v v v
period 1 - i -
Quantity 0 J n [ P |

4. After reading the agreement terms, click the checkbox.

5. Click Checkout to go to the payment page.
Note: You can go back to the previous page by clicking the button Back.

g Available space - 995 GB 22 AccountManagement & BenQ @ language A7

cms soaccast | License Extension e

Shopping Items (1)

By Device
By Channel
pack period Price Quantity Summary
*  File Management
Basic 1Year UsD$ 1 1 - 149.9 [ ]

Verification

Hy Faverte Back Total Price :USD5149 9 ! | 5
4 —

Report Analysis (]t rave read and understood. Agreement eme]

Advanced Application

License Management

About

BenQ X-Sign 13



6. After checking the quantity and the total price, click PayPal Checkout.

8 Available space - 99.5 GB. 22 AccountManagement & BenQ @ Language A7

Broadcast \ License Extension b

) Confirm Order Detalil :
By Device

By Channel Shopping Items

pack period Price Quantity Summary Order ...
»  File Management
Basic 1Year USD$ 149.90 : | 149.9 2019-1.
* Verification
> My Favorite
Total Price :UsD$ 149, 9 | (i 6
»  Report Analysis

Advanced Application

License Management

About

7. Log in the Paypal Account and finish the payment.

BenQ DCC's Test Store

' PayPal W $149.90 USD v
Pay with PayPal English + - .
1 - payPe!
Email J
[ Password J New. Faster. Easier.

Welcome to the new PayPal checkout!
7 Log In The s‘ecunty you rely on — now even faster.
It's everything checkout should be.

Having trouble logging in?

or

Pay with Debit or Credit Card

Terms UserAgreement Privacy Feedback ©1999-2019 @

8. You can also pay by your credit card.

. PayPal W $149.90 USD v
Pay with debit or credit card
We don't share your financial details with the merchant.
Country/Region . PayPal is the safer, faster
Taiwan
way to pay
W E =] . No matter where you shop, we help keep your

financial information more secure.

Card number
Expires csc =3
First name Last name

Billing address

Address line 1

Importing the license(s) to X-Sign Manager

Before controlling your device or playing the content remotely, you must pair the device with the
license in X-Sign Manager.

14 BenQ X-Sign



I. You have to buy license(s) from Manager directly or from BenQ reseller. If you buy from Manager,
the license will be sent to your Manager account directly. If you buy from the reseller, you have to

import license(s) yourself.

2. Go to License Management > License List and click Import License Code.

g Available space : 99.5 GB

& Account Management

28nQ @language g4’

P oo | LicenseList

By Device

By Channel

File Management

Verification

My Favorite

Report Analysis

Advanced Application

Import License Code

«

License Management

License List

License Extension

History and Setting

About

3. Enter the license code here. Click Add to import multiple licenses at one time.

8 Available space : 99.5 GB

Status

Expired
Expired
Expired
Expired
Expired
Expired
Expired
Expired

Used

Device Name

test2

Y8MU35VS
KRNR6GNHO101
3NDXX7EB
REH

1st floor

145678
YHN3VURU
XYC6AZLA

3NDXX7EB

Device
D

QNQS6E..

Y8MU35VS

KRNR6G

3NDXX7EB

LSS9GQ..

BUWU2F..

EJVROYFA

YHN3VU..

XYCBAZLA

3NDXX7EB

pack

Premium
Premium
Premium
Premium
Premium
Premium
Premium
Premium
Premium
Premium
Premium

Premium

3vear

SYear

2Year

1Year

1Year

1Year

1vear

1Year

2Year

1vear

1vear

2Year

Activate
don

2016-02-....

2017-01-

2017-02-.

2017-02-.

2017-02-...

2017-02-...

2016-04-...

2017-02-...

2017-02-...

2018-02-....

2 3 4 5 >

Expiratio
n Date

2021-02-...

2018-01-

2018-02-

2018-02-.

2017-10-...

2018-02-...
2018-04-...
2018-02-...
2018-02-...

2020-02-...

&2 Account Management

License Code

02NUSQWTQCVQ3ZFD

02UNUHUMQYNBNXIX

02EAYFXVOTQPIPTY

029RWWRJID1IEAWTMO

024FAXPOMXVMORRY

02V6MNCRFBQLS5CO

02EAFUGMO6LVZUEO

02VSKYID6ZE3WEUV

029KCCKVHSEQYG14

02MDTNOIC9Z60EA46

02M6430RN7IYZBE4

02MARGY40VZ36TL7

Mapping

&8enQ @Llanguage @'

CMS Broadcast

By Device

By Channel

File Management

Verification

My Favorite

Report Analysis

Advanced Application

License Management
License List
License Extension
History and Setting

About

License List

Please input license(16 characters)

4. After entering the license code, click Import license.

5. You will see the imported licenses on the license list.

6. Now you can start to pair your devices.

Import license

BenQ X-Sign
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Mapping the license

I. To map the license, go to License Management > License List. Click Mapping to continue.

Available space - 100 GB Account Management &, BenQ @ Language

cMs Broadcast ‘ License List
Import License Code Search Q
By Device
Status Device Name Device Solution  Type Activated  Expiratio License Code Mapping
By Channel D on n Date
Expired Premium  OYear30Day 2017-01-1.. 2017-02-1.. ACMARUFVM2X623AH
> File Management
Expired Premium  OYear30Day 2017-01-1.. 2017-02-1.. ACMSZ33834TGX2UH
*  Verification
Expired Premium  OYear30Day 2017-01-1.. 2017-02-1.. ACMVAUM63P54333A
. ;
MyEavortic Expired Premium  OYear30Day 2017-01-1.. 2017-02-1.. ACMX4Q3M384UVZNA
» Report Analysis Expired Premium  OYear30Day 2017-01-1.. 2017-02-1.. ACM3H3CMULGRV42C
v Actvencer Application Used HRSLB23V HRSLB23V  Premium  3Year 2010-09-1.. 2022-09-1.. ACPA3B6M2U26B7VJ
Used BenQ C4PUZT6T  Premium  3Year 2019-12-2... 2022-122... ACP9SV33GDHE3Y2J
~ License Management
New Premium  3Year ACPPRBBNMQ76JAEG
I License List
License Extension
History and Setting
About

2. Fill in the following fields and click Finish to map the license.

Add a New Device

*Device ID
*License Code Pairing ACPPR88NMQ76JAEG Choose
*Device Name
*Device Location Choase

Category Uncategorized

Channel Unsubscribed

Description within 150 characters

Notice

Mew device has been created

16  BenQ X-Sign



Checking the License upgrade notice

I. To check the license upgrade notice, click n at the top right corner.

Available space - 99.5 GB.

aa Account Management 8, BenQ @ Language

Broadcast

All devices

I By Device Add Category

Add a New Device

» B All devices (17)

X-Sign Player Update

By Channel

[7] Al devices

File Management

Status ¥ Name

*»  Verification
> My Favorite 1st floor
*  Report Analysis .
i V20T
* Advanced Application
~ License Management
v2.01T2_2
License List
License Extension 3 1
L xsen ARES3U4K
History and Setting X A
About
- e

Channel Name

Howard_0826
Howard_0826
Howard_0826
Howard_0826

teste

2. You can see the notification(s). Click to see more information.

All devices

«

s, Account Management

Add Category

Add a New Device

X-Sign Player Update

v B All devices (10)

DAIE devices
Stat ~ Name
us

): X-Sign  AlbertPC

B AKNB

All license codes will upgrade to Premium version.

Channel Name

PMSG CC Video ..

Albert's Channel

After X-Sign Manager upgrade, all license codes will upgrade to Premium version.

After license code expires, you can decide which license type to buy.

Search..

Device ID pack
coppzm s&%ﬁfzg 11:01:12
FFMHARS?

VZVSKPE2

ARES3U4K

GRXIDXTQ Premium

2020-08-04 11:05:41

& BenQ

@ language @
Notification

All license codes will upgrad...
Sign Manager upgrade, all lic

Device ID

pack

G3XNZLKA

ZRK27T4Z

Basic

Platform

Content Mangment v w4
Channel Scheduling v v
Device Control S
Xsign Player Remote Upgrade v
Video Wall v v
System Report v v

Interactive Function

Premium
i
v v v
v v Vs

v

v

v v

v v v
v/ v v

Note: You can delete the notification by clicking the trash can icon

notifications.

Close

. Click Clear all to delete all

BenQ X-Sign 17



Manager
Pairing the device with X-Sign Manager

Watch demonstration video:

If you want to play the content from Internet or control multiple devices remotely, you have to pair
the device with X-Sign Manager.

I. Launch X-Sign Player.

2. Press Esc button on Windows Player or MENU on the device remote controller to see the
menu bar.

a Settings

G Switch Mode

0 About

| T

3. Choose Switch Mode to switch to Manager mode.

== Play from File

Q Settings

o4 switch Mode

© Abou

[}-v Quit

18  BenQ X-Sign



4. Choose Pair to start pairing.

Switch Mode

Unpaired
The source of content is from Manager.

Q Standalone(USB)
Device ID: Unassigned
Device Name: Unassigned

Pair

Local Delivery and Interactive
function

Manager
(Pairing...)

Close

5. Get the Device ID on this page then go to X-Sign Manager to pair the license.

New Device

DeviceID: JMK54MR3

1. Please check the network status.
2. Please bind the Device ID and pairing code to activate the feature of X-Sign Manager.

Status: Pairing...

Back

BenQ X-Sign 19



6. Go to X-Sign Manager. Then go to By Device and choose Add a new Device.
W | A deies
| By Device S e Add Category X-Sign Player Update

By Channel
[ All devices
* File Management
Status ~ Name Channel Name

¥ Verification

* My Favorite

Lstfloor Howard_0826
* Report Analysis

Advanced Application

v20IT Howard_0826

License Management

About

BB

v2ama 2 Howard_0826
-
l x“o‘ ARES3U4K Howard 0826
- testgwe teste
—
l 123456 Howard_0826

7. Enter required information as below.

*Device ID: the device information from X-Sign Player.

New Device
DevicelD: JMK54MR3

1. Please check the network status.
2. Please bind the Device ID and pairing code to activate the feature of X-Sign Manager.

Status: Pairing...

Back

*Mapping license code: Choose the license you want to pair with the device. You have to make
sure you already buy the license and import to X-Sign Manager.

20 BenQ X-Sign



*Device location: Choose the city where your device lies in. Time zone of the device (Android)
needs to be the same as you set here.

Available space :95.1GB 23 Account Management & Head Quarter @ Language  #h 2

BEEl oo | Al devices

| o Add a New Device

» BS All devices (7)

By Channel

File Management A *Device ID

Verification B | *License Code Pairing

My Favorite

*Device Name

Report Analysis

Advanced Application

Category Uncat 4 J
»  License Management ncategorize
About Channel Unsubscribed
Description within 150 characters

8. After you finish the setting, click Finish to continue.

Avaiable space : 951 GB 22 Account Management & Head Quarter @ Language . °
B - | Al devices
Add a New Device
I Sy Device » BS Al devices (6)
By Channel
> File Management Devic 1D | |
This field is required
> Verification
*License Code Pairing ACPL-3NM2-CE2D-2Z4A Choose
> My Favorite
> Reort Aty “Device Name M
> Advanced Application *Device Location Taipei Choose
»
License Management Gaiogory sor [ — N
About
Channel Demo Room
Dessiiption within 150 characters

9. A message, “New device has been created”, will show up on the screen when the signage is
successfully paired with X-Sign Manager.

Warning Message

New device has been created

BenQ X-Sign 21



10. You will also see the message shown on the signage.

Switch Mode

Unpaired
The source of content is from Manager.

o Standalone(USB)
Device ID: Unassigned
Device Name: Unassigned

Pair

Local Delivery and Interactive
function

Manager
(Pairing...)

Close

I'l. Now you can control your device and play content remotely from X-Sign Manager.

Creating the channel

Woatch demonstration video:

Follow the steps A to N to create the channel.

* A. Click By Channel.
* B. Click Add New Channel to the creation page.

Available space : 99.5 GB 22 AccountManagement 8 BenQ @ language g

IBEE oo | By Channel
By Device Add New Channel B Search

By Channel A
| ¥ Type ~ Channel Name Equipment amount
> File Management Normal 201907 9
*  Verification Normal 0718 2
» My Favorite Normal 12345_Channel :
20190707test
* Report Analysis ol 2
. Normal abed o
> Advanced Application
Normal Howard_0826 12
> License Management
Normal teste 2

About

* C. Enter the channel Name.

* D. Select the default playing content when there is no schedule in this channel.

22 BenQ X-Sign



* E. Choose to enable anti-image retention.

* F Fill in the description of the channel.

* G. Click Confirm to finish the creation page.

g Available space : 99.5 GB

@& Account Management 8 BenQ @ Language 4 °

cms groadeast | BY Channel

Add New Channel

By Device
| By Channel ( Channel Name within 50 characters |
*» File Management D File Content video
» Veriication File size fimit : 100MB
last file
> My Favorie @ pictre | xsignBackground png
> Report Analysis Support file format *.png, * jpg. Max dimensions: 4096 * 4096
* Advanced Application E Anti retention D ©Once enabled, we will play an anti-retention animation on your screen every 6 hours. |

(We suggest you to enable this setting when you plan to play any static content for a long time.)

License Management

About

Preview

Description within 150 characters

G|« |

* H. Select to finish the settings.

¢ |. Select to add the existi

ng device to the channel.

Group Setting Finished

The channel is successfully created. Are you going to set equipment for this

channel?

H

Setting Finished

* J. Re-edit the information of the channel.

* K. Add the existing device to the channel, then you will see a new page.

By Channel

Channel Management

Channel Name

File Content

Anti retention

Description

BenQ

picture
X-signBackground.png

Disabled

None

J @ Delete channel

Manage Device

K Add unsubscribed devices to this channel.

Device Name » Device ID Category

Device version

Search

License Status

BenQ X-Sign
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* L. Select multiple devices to add into the channel.
* M. You can search the name of the device in the search bar.

* N. Click Confirm to finish the operation.

| By Channel

Add equipments to this channel M

[] |pevice Name « Device ID Ccategory Device pack Expiration Date
version

¥ | Bobby_PC_0514_need weed E6J5XCDJ 420 2533 Premium  2020-05-14 15:01:20

Scheduling the content by channel

E55 5

Woatch demonstration video:

With X-Sign Manager, you can easily play the same content on multiple devices remotely. You can also
play different content whenever you want.

I. Be sure that the device’s license in the channel hasn’t expired yet.
2. Go to By Channel, then choose the channel you want to play the content.

3. Click and you will see the schedule management page of Channel. Click the time slice you
want to set schedule.

P Available space -
99.5GB SaAccountManagement 9 penQ @ language g
i —

W| By Channel

i o
By Dt Add New Chanrel B £ P Search
By Channel
Type ~ Channel Name Equipment

amount
* File Management

Normal RFTVLZZ ]
* Verification
Normal 0718 2
* My Favorite
Normal 20190707test 0
* Report Analysis
Normal 2019070Ttest_ 0
* Advanced Application
. Normal abed 0
* License Management
Normal Howard 0826 12
About
Normal teste 5
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4. You will see the schedule setup window. Below is some required information.

A. Select the project you want to play on the channel. Be sure to upload your project file to
Manager first.

B. Set the schedule time you want to play the content.
C. Enable to play content all day long.

D. Select the priority of the project. If it is urgent, select High for interruption scheduling. High
priority schedule can overwrite Normal priority schedule by overlapping time blocks.

E. Enable to play content periodically.

F. You can set time here. You have to set the end date and choose to repeat by day or week.

Create Schedule (071s)

Schedule Name Tes{ 001 l

A Content Mot selected Choose
B Duration B 2019-08-29 @ 17 00 o @ 12 0o AlDay  J
D Priority High ‘@ MNormal
E Cycle )
Day Every 1 Day
F Week End |8

5. After all configuration is set, click Submit.

6. You will see the schedule on the management page.

Ll e 22 Account Management & BenQ @ Language ,.1
995GB -

M Channel » Schedule management (0718)

2019/08/25 - 31 day [ week | montn |
By Davice
| By Channel 8125 SUn 8/26 Mon 8127 Tue 828 Wed 8/29 Thu 2130 Fri 831 Sat
*  File Management am 04
b Verification am 05
* My Favorite am 06
*  Report Analysis am 07
*  Advanced Application am 08
* License Management .
am 09
About
am 1
am 11
pm
pm 01
pm
pm 03
m 04
. v E———=c=
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7. Double click the schedule event, and you can see the status of devices in the channel.

8. No matter by device or by channel, you can create and edit time blocks in the timetable by
clicking and dragging.

Scheduling the content by device

Watch demonstration video: =8

I. Go to By Device, then choose the device you want to play the content. Click to go to the
schedule management page.

| Available space
995GB

B - | A deices o
«

By Device Add a New Device Add Category X-Sign Player Update Search
» B8 All devices (16) 8 = Ty E
5 £

[[] Al devices

ZsAccountManagement 8 BenQ  @Llanguage g1

*  File Management

» Verification Staius ~ Name Channel Name Device ID pack

* My Favorite

1st floor Howard_0826 BUWU2FNY
*  Report Analysis

» Advanced Application
* License Management V20 1T Howard_0826 FFMHARST

About

v2omz 2 Howard_0826 VZVSKPE2

o NN

o ARES3U4K Howard_0826 ARES3U4K

&

B
- testawe feste GRAUDKTD 2070.06.04 110541
— B
. . ) remium
R Howard_0826 UVASSKIS s

2. Click the time slice you want to set schedule.

N Available space -

2:Account Management  QBeno @ language )

995GB
cMs Broarcast :
_ Device » Schedule management (v2.0 IT) (i ]
B [ [ D] o
By Ctnnel 8/25 Sun 8126 Mon 8127 Tue 8128 Wed 829 Thy 8/30 Fri 8131 Sat
* File Management am 04
> Verficaion am s
* My Favorite i
am
* Report Analysis
am 07
*  Advanced Application
am 08
» License Management
am 09
About
am 10
am1l
pm 12
pm 01
pm 02
pm 03
pm 04
¥ pmos
pm 06
om 07

mpexpired  @@BChanne! Schedule  @BDevice Schedule  @EUnverified
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3. You will see the schedule setup window. Refer to Scheduling the content by channel on page 24

for more information about A-F

Create Schedule (o718)

o @ 19

Schedule Name Tes{001
A Content Mot selected
B Duration | £ 2019-08-29 0] 0o
D Priority High @ MNormal
E Cycle 1
Day Every 1 Day
F Veek g &=

4. After all configuration is set, click Submit.

5. You will see the schedule on the management page.

Available space :
99.5GB

Broadcast

| By Device
By Channel
* File Management
» Verification
* My Favorite
' Report Analysis
»  Advanced Appiication
»  License Management

About

Device : Schedule management (v2.0 IT)

&0 an

8/25 Sun 8/26 Mon 8/27 Tue

1 pmos
om 06
om 07
pm 08
pm 09

pm 10

exnirerd  @EBRChannel Scharule  @EBDevice Scherule @ Inverified

2019/08/25 - 31

8128 Wed

oo AlDay B

Cancel

3

&2 Account Management @ BenQ @ Llanguage g

(i}

8129 Thu 8/30 Fri 8/31 Sat

6. No matter by device or by channel, you can create and edit time blocks in the timetable by
clicking and dragging.

Editing the device management structure

Watch demonstration video:

BenQ X-Sign

27



In X-Sign Manager, you can manage devices with hierarchical structures which make you control
multiple devices with ease.

I. Click Add category to create a folder.

Account Management lead Quarter @ Language @

Broadcast All devices &

. Add a New Device Add Category X-Sign Player Update Search. Q

By Channel
[] All devices
> File Management
Statu ~ Name Channel Name Device ID pack
*  Verification s
» My Favorite 3 . 420
»  Report Analysis 2 & BQT
) 1 = edu
*  Advanced Application
1 & Jamba Juice

License Management

About

Available space : 95.1 GB Account Management ead Quarter @ Language g

BEE oo | Al devices &

By Device Add a New Device Add Category X-Sign Player Update Search. Q
~ B Al devices (7)

By Channel = w20
[] All devices
> File Management » 8 QT (2
o W edu (1) Statu ~ Name Channel Name Device ID pack
*  Verification s
» BB Jamba Juice (1)
» My Favorite i Premium
o
PC_0514_need_weed Unsubscribed E6J5XCDJ S0 A S
» Report Analysis
— 2 = BQT
»  Advanced Application
2 . 420
» License Management
: § B edu
About
i B Jamba Juice
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2. You can see the folder structure on the left side. You can easily create a hierarchical folder
structure.

wailable spac

Account Management lead Quarter @ Language

B oo | All devices

By Device

By Channel

File Management
Verification

My Favorite

Report Analysis
Advanced Application
License Management

About

S All devices (7)
| 2002
BT ) [] All devices
e () Statu ~ Name
s
» I Jamba Juice (1) -
LE PC_0514_need_weed
2 = BQT
2 = 220
1 = edu
1 W Jamba Juice

X-Sign Player Update Search. Q
Channel Name Device ID pack
Unsubscribed E6J5XCDJ ki)

2020-05-14 15:01:20

3. Click Add a New Device then set it to the related category.

Available space : 99.5 GB

Account Management BenQ @ Language

By Device

By Channel

File Management

Verification

My Favorite

Report Analysis

Advanced Application

License Management

About

<

Add a New Device

~ B Al devices (16)
» [ RGT (3)
B Test 002 (0) *Device ID
W ittt (0)
*License Code

Pairing

*Device Name

*Device Location

Choose

Category Uncategorized
Channel Unsubseribed
Desription within 150 characters

BenQ X-Sign
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4. You will see the device in the related folder.

8 Avaliable space - 895 GB &8 Account Management @ BenQ @ Language

BT - | A devies  RGT -

By Device Add a New Device Add Category X-Sign Player Update Search
~ I Al devices (16)

[“IreT

* File Management B Test 002 (0) o
v Verification B9 it (0) Statu ~ Name Channel Name Device ID pack

s
* My Favorite

5 4ﬁ)(—Sign KRNRBGNHO101 Howard_0826 KRNRBGNH
* Report Analysis A -
»  Advanced Application
oo N o & Premium
»  License Management )‘ X-Sign 3NDXX7EB Howard_0826 3NDXXTEB 2090.09-13 18 154
About
1 B level3

5. For existing device(s), click to transfer it to the correct folder.

All devices el
Add a New Device Add Category X-Sign Player Update Search
~ B Al devices (16)
. o
. ] L B 0
» BB RGT (3)
™ et 002 (0) [ Al devices
I ittt (0) Statu ~ Name Channel Name Device ID pack

k- 1stfloor Howard_0826 BUWUZFNY

L=
- v20IT Howard_0826 FFMHARS?

= ‘
s ARES3U4K Howard_0826 ARES3U4K

K
h

Pr
- testqwe il SRADXEO zogzg“:gwua 11:05:41

6. Now you can start to customize your device structure.

Pushing Real-Time Message to your BenQ Smart Signage remotely

5

Watch demonstration video:

With Real-Time Message on By Channel, you can easily push instant message to single or multiple
devices. You don't need to edit content again.

I. Make sure that the device has already paired with X-Sign Manager.

2. You must create one channel and move device(s) into it.
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3. Go to By Channel, select the channel you want to push the message to. Then click & .

w Available space : 895 GB 22AccountManagement @ BenQ @ Language 4

1t "
| By Channel
Type ~ Channel Name Equipment amount
»

File Management SO, RFTVLZZ g

»  \Verification

Normal 0718 2

* My Favorite Normal 20190707test o

*  Report Analysis Normal 20190707test_ 0

+  Advanced Application Normé abed 0
*  License Management Normal Howard_0826 12

About Normal teste 2

4. You will see the message settings page.

A. Enter the message you want to push.
B. Choose the style and layout for the message.

C. Set the duration for playing the message. The maximum time to play the message is 24 hours.

2aAccountManagement @ BenQ @ language g °
Real-time message

Scrolling text: A

Type text here

Text style:

Font size Foreground Background
color. color

-

Scrolling text setup:

Scrolling text direction: Scrolling text position:
ec > O @ O= O Ol I C
Scrolling text speed: Start time End time:
D 00:00-00
o5 - o w - 0 - 0 4 1o w - i A o <] v

< o o

5. You can click Preview to see what the effect looks like on your display.
6. After you finish the setting, click OK.
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7. You can click History to see the record of each real-time message event.

History

Duration Content State

2017-12-21 00:00:00-2017-12-21 01:00:00 Testinstant me  Sent

ssage

8. You can also see the status or even delete it.

Controlling the device remotely

Watch demonstration video: i

With X-Sign Manager, you can control your devices remotely. The function is only compatible with

BenQ Smart Signage Series’ hardware.

I. Make sure that your device is already paired with X-Sign Manager and is online.

2. Go to By Device, then choose the device you want to control, and click #* .

Available space : 95.1 GB 22 Account Management & Head Quarter @ Language @ °

B oo | Alldevices > 420
Add a New Device Add Category X-Sign Player Update
~ I Al devices (7)

Search

/_*o*

By Channel B 2002
[J420
»  File Management » 8 QT (2)
® () Statu ~ Name Channel Name Device ID pack
»  Verification
» [ Jamba Juice (1)
> My Eavorite Premium
Demo_550K_420_for_test Mcdonald breakfast ~ 83NQ2563 ST
» Report Analysis
»  Advanced Application Premium
Demo Room AXBGELBC
festitpsllest 2023-07-27 10:07:57

*  License Management

About
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3. You will see the Device control page. You can control Device status/Screen/Power/Voice/
Others (Clear Data).

9 Available space : 95.1 GB

22 Account Management

& HeadQuarter @ Language @ °

CMS Broadcast

By Device

By Channel

File Management
Verification

My Favorite

Report Analysis
Advanced Application
License Management

About

All devices > 420

Device Control ( Device Name : Demo_550K_420_for_test)

~ I Al devices (7)

B 420(2)
Device status
» B BQT (2)
B cdu) Offline

(Last Synchronized:2019-12-17 12:00:27)
» I8 Jamba Juice (1)

Screen

The screen can be tumed on or off manually/automatically for power saving.

Automatic switch mode
off

Power

4. You have to reload this page after setting the device to get the latest status.

Updating device Player remotely

—_—
Watch demonstration video: %" Te g
=

With X-Sign Manager, you can easily update X-Sign Player on your devices remotely.

I. Go to By Device, then click X-Sign Player Update.

g Available space : 95.1 GB

22 Account Management 8 Head Quarter @ Language 4 °

|

cMs Broadcast ‘ All devices > 420

By Channel

File Management
Verification

My Favorite

Report Analysis
Advanced Application
License Management

About

Add a New Device Add Category
~ [ Al devices (7)

X-Sign Player Update

B 420(2)
420
» I8 BQT(2) a
- edu (1) Statu ~ Name

s
» I Jamba Juice (1)

| | Demo_550K_420_for_test

| I test_test_test

Channel Name

Mcdonald breakfast

Demo Room

Search

B s 0 *x

Device ID

83NQ2563

4XB6ELBC

pack

Premium
2023-06-25 13:35:44

Premium
2023-07-27 10:07:57
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2. You will see a list of devices available to be updated. Select the device(s) you want to update.

X-Sign Player Update n
Search
Device Name = Channel Name Category Description Current Last Update
version Update Status
d

u 123458 Howard_0826 Uncategorized v2.403 Haven't ..
1st floor Howard_0826 Uncategorized v2321 Haven't
u A6BWTHGE Howard_0826 Uncategorized v2.303 Haven't
ARES3U4K Howard_0826 Uncategorized v16.153 Haven't
GEMWT29G 0718 Uncategorized v2501 Haven't
Ll RFTVLZZE 0718 Uncategonized v2501 Haven't
Ryan_Test_Download Howard_0826 Uncategorized v2.0.00 Haven't
] testqwe teste Uncategorized v2.0.14.1 Haven't
v20IT Howard_0826 Uncategorized V20111 Haven't
v20IT2 2 Howard_0826 Uncategorized hello v2.0.109 Haven't

3. During updating, the playing process will temporarily be stopped.

4. After the device is updated successfully, it will be removed from the list. The device will be
updated to the latest version of Player.

5. If the device is offline, the system will wait until the device is online and send the update request.

If you want to update Player, you have to reboot the device or the device can't play content
normally. Go to Device control page and press Reboot under Power. Refer to Controlling
the device remotely on page 32 for more information.

Managing the calling system

I. To manage the calling system, select Advanced Application > Calling System.

Available space : 89.5 GB

B - | Caling System

Please select a device or add a new one.
By Device

T

+

AT TR T PP TP LT L

By Channel

*  File Management

*  Verification

o ————
" s e i W

* My Favorite

* Report Analysis

~ Advanced Application

| | Calling System

API Widget

System Notification
* License Management

About
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2. Click the panel to manage the calling number.

Calling System

Please select a device or add a new one.

3. Enter the corresponding number on the queuing widget in X-Sign Designer for the panel and
click Next.

2018/3/30 5:35:00PM =

1 ., % Current Number
1 2 3
4 5 6 126
7 8 9
0 Enter Next
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4. The current number to the panel is shown on the screen.

S Current Number

127

Next

5. You can also edit the number by clicking other function buttons === . By selecting Setting
alert sound, there will be a sound when the number changed.

4/8/2021 9:14:20AM ==

Number Restart

Setting number
period

Nur
Setting alert sound
Shortcut

Logout

6. To restart the queuing number, select Number Restart and click OK.

Are you sure restart queuing number?

Cancel n
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7. The queuing number is restarted.

% Current Number

0

Next

8. To set the period for the next queuing number, select Setting number period, input the
number, and click OK.

Please input the number for period of next queuing number.

E

9. The number period is set.

Update success

10. Select Shortcut for more information about how to add a shortcut to the desktop.

I'l. To log out, select Logout and click OK.

Are you sure logout?

Cancel
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Note:

“Equipment status error” message occurs when the equipment is not online.

Equipment status error, please checked.

* Android_Box_W
* AlbertPC
* Barcelona

confirm and continue.

Creating an API table in X-Sign Manager

I. To create an API table, select Advanced Application > APl Widget.

Available space : 95.1 GB count Management jead Quarter @ Language @

B oo | APIWidget
s

By Channel

Status Source Table Creator Modified date

File Management

*  Verification
» My Favorite
Status API Table Creator Modified date &
» Report Analysis
Specialties 2019-05-10 01:56 PM
~  Advanced Application
Steaks 2019-05-10 01:56 PM

Calling System

| API Widget Favourites 2019-05-10 01:56 PM

System Notification
» License Management

About

2. Create the APl Widget configuration.

lable space : 95.1 GB count Management 8 Head Quarter @ Language @

cMS Broadcast ‘ API Widget

n >
By Device Create Al idget P 4 &

By Channel

Status Source Table Creator Modified date
*»  File Management

> Verification

10 01:56 PM

> My Favorite

Status API Table Creator Modified date\
> Report Analysis
Specialties 2019-05-10 01:56 PM
~ Advanced Application
Steaks 2019-05-10 01:56 PM
Calling System
API Widget Favourites 2019-05-10 01:56 PM

System Notification
» License Management

About
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3. Enter the settings of the configuration.

Input Web URL:

Wwebh URL

key value [+

I'm not a robot
reCAPTCHA
Privacy - Terms

4. Create a source table for API.

= Available space : 8.8 GB

APl Widget

Source table name
CounterPrijs (#8

HTMLElementID @8 Web URL

https://apitest.beng.com/custom_api_server/testd.json

ProductGroupiD #8
ProductGroupO

oductD §§

ProduciiNaam {§§

5. Select the tags from Json to the source table. Click Save to continue the creating process.

| AP| Widget

Source table name
unterPrijs @

HTMLElementiD @ Web URL

hitps #/apitest beng c stom_api_server/testd json

ProductGrouplD @
ProductGroupOrder §

CounterPr HTMLEle ProductG ProductG

600 1
1
320 1
160 b i
210 h;
4
300 1
5
back to list

BenQ X-Sign
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6. A warning message will pop up. Click Yes to continue.

Warning Message

Source table saved.
Continue to create the table?

7. You can preview the selected range of the table. Click next to continue.

Avallable space |
98.5 GB ount Managemeant Albert Kang @ Language

B
R = | ..o i abie

By Device

Select column and row to edit API table
By Channel
- Preview

FRENanecy, Select Row Range:

CounterPr HTMLEIe
My e Al @ Range | 15

*  Repori Analysis
500 3361133006044
v Advanced Appiication V] ] O 1 3758¢f7en6613
7340
*  License Management
CounterPr HTMLEle ProductG
320 ae0e1130d1394c
About
2 508508208130
§0D 3361133006044 azfa62iz-caza-d 78960
/] 3758ci7ebb813 200-9050-16117
b
[ fitcat 160 62DETCr507464
2 bebasaadzZale
320 as0e1120f304c azfaG2i2-caza-4 Aol
] 5985082081830 200-8050-16117
78960 6014cdb
e 210 7100187410843
4 3eazz22dgfasd
160 62087ci5d7464 azfabiz-caza-d ke
% bebaSasdz2ale 200-8050-16117
aelfad 6b14c46
300 edoddel143414
5 876800134351
210 710c19f4/bbe43 azfab2i2-ca?ad c3d6ed
1 3eaz222081a5d 200-9050-16117
a75e5 6D14¢46
300 ededdel143414 aZfaB2i2-ca2a-4

back to list m
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8. The source table is successfully created.

Available space °
X 98.8 GB &2 Account Management 2 BenQ @ language 4
Broadcast A
BN oo | o) wigger
By Device
Create AP1 Widget
By Channel
* File Management
Status Source Table Creator Modified date
+ My Favorite
* Report Analysis ® Table 01 Albert Kang 2019-01-09 06:16 AM -~
s Adlvanced Appiication Status API Table Creator Modified date &
Calling System
I AP Widaet | New table 1 Albert Kang 2019-01-09 07:10 AM |
System Nofification
= demo_um Albert Kang 2018-12-2807-40 AM ~
+  License Management 5 I
Abicut REAL_CASH2 Albert Kang 20181211 08:28 AM v
ak1211 Albert_Kang 2018-12-11 01:18 AM v
demo_source Alhert_Kang 2018-12-07 01-20 A} v
Restaurant 2018-12-06 06:24 AM v

Setting Verification

Verification in X-Sign Manager functions to control content and schedules to be played on X-Sign
Player.

Files

Before a file is delivered publicly, it has to be checked by the administrator. Only when the
administrator clicks Approve can the file be added to the schedule.

To verify a file:

BenQ X-Sign 4]



g Available space 1995
GB
BEE 5= | Archive Verification

Pending@)  Approved  Rejected

By Device
By Channel Reject
»  File Management O File
~ Verification 1] ol
-
Schedules a ] test?
> My Favorite
» Report Analysis

Advanced Application

License Management

About

I. Go to Verification > Files to check the files uploaded via X-Sign Designer.

2aAccountManagement 8 BenQ @ language g%

Size (MB) Resolution Uploader

272 1920x1080

014 1920x1080

userl005_1_re

userl005_1_re

2. Select the file to be approved or rejected, then click Approve or Reject.

gy Avaiabie space 995
Py s

BEE :o— | Archive Verification

Pendng@) ~ Approved  Rejected

Search

Upload time ~

2019-08-30 125
715

2018-12-06 09:3
509

2aAccountManzgement @ BenQ @ language A4

By Device
T e
*  File Management O File Size (MB) Resolution Uploader Upload time ~
~  Verification | V1] m 272 1920x1080 userl005 1 re 2019-08-30 12:5
Schedules O - test2 014 1920x1080 userl005_1 re SBULSB—IZ—QG 093
» My Favorite
* Report Analysis

» Advanced Application
> License Management

About

3. You need to fill in the reason you reject the file to be added to the schedule. This is a required

42

field. Click Submit to proceed.

Reject upload files

Publish Content Publish To
w2om
Test 001

BenQ X-Sign

Publisher

joyl234

Schedule Status

Reject reason

Expired at 2019-08-29 17:10:04

Cancel




4. The file now is under the approved (or rejected) section.

22 AccountManagement 8 joy1234 (@ language g ¢

Archive Verification

Pending@) | Approved  Rejected

Clear All

Search

File Size (MB) Resolution  Uploader Upload Censor Verified ~ ~
time time.
" 272 1020x1080  userl005_1re 2010083012 joyl234 2010-08-30 16:
5715 4810
n RFTVLZZ 0.46 1920x1080 userl005_1 re 2018-12-0609: joy1234 2018-12-06 09

Schedules

27581 2939

After a scheduled time is set, it has to be checked by the administrator. If the scheduled time is not
appropriate, the administrator can reject the schedule. Only when the administrator clicks Approve
can the file be played at the scheduled time on X-Sign Player.

To verify a schedule:

I. Go to Verification > Schedules to check the schedule(s).

P Avaiable space: 995
S

Pending@)
By Device

By Channel

File Management D

Verification O

Files

Schedules

My Favorite

Report Analysis

Advanced Application

License Management

About

M\ Schedule Verification

22 Account Management 8 BenQ @ language g4 °

Approved Rejected

Reject Search
Publish Content Publish To Publisher Schedule Status ~

V20T BenQ Submitted for verification at Q@
Class C 2010-09-05 15:20:49
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2. Select the schedule to be approved or rejected, then click Approve or Reject.

23 Account Management 8 BenQ @) Language Aﬁ

Schedule Verification

Pending@ Approved Rejected

| 1

Publish Content Publish To Publisher Schedule Status ~

v20IT BenQ Submitted for verification at Q
Class C 2018-00-05 15:20:49

3. You need to fill in the reason you reject the scheduled time. This is a required field. Click
Submit to proceed.

Reject upload files

Publish Content  Publish To  Publisher = Schedule Status Reject reason
v2.01T BenQ Submitted for verification at 2019-09-05 15:20:49
Class C

4. The file now is under the approved (or rejected) section.

22Account Management & BenQ @ language  4°

Schedule Verification

Pending Approved Rejected

Clear All Search Q

Publish Content Publish To Publisher Schedule Status ~

[ High } v201T BenQ BenQ 2019-09-05 07:42:39

ClassC has approved
v20IT BenQ BenQ 2019-09-05 07:19:53

menu has approved

V20 1T joy1234 joy1234 2019-09-02

menu 08:08:12 has approved

[ Normal ] 1st floor joy1234 joy1234 2019-09-02

menu 07:47:18 has approved

0718 joy1234 joy1234 2019-00-02

menu 07:47:11 has approved
V201T joy1234 joy1234 2019-08-02

menu 07:43:52 has approved
V20T joy1234 joy1234 2019-00-02

menu 06:58:37 has approved
V20T joy1234 joy1234 2019-09-02

menu 06:57:16 has approved

-
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5. Youcan click @ to preview the file uploaded from X-Sign Designer.

Available space : 995
GB

cms aeadesst | Schedule Verification
Pending@) Approved Rejected
By Device
By Channel Reject
* File Management E Publish Content
= Verification
Class C
Files
Schedules
» My Favorite
* Report Analysis

Advanced Application
* License Management

About

23 Account Management & BenQ @@ Language 45

Publisher Schedule Status ~

BenQ Submitted for verification at
2019-09-05 15:29:49

6. You can view the file on X-Sign Player and edit schedule. Click Approve and Publish or

Reject to proceed.

Schedule Verification

View in Player #

Edit schedule

Getting the system notification

demo

Scheduled Time :
09/07 14:30 - 17:00

Priority -
Normal

Cycle @
Off

Publish File :
1st_interactvie_template_portrait

Scheduler :
BenQ

Approve and Publish Reject

I. Go to Advanced Application > System Notification.

BenQ X-Sign

45



2. Enable System Notification.

46

Available space - 995 GB 22 Account Management &, BenQ

m Broadcast \ System Notification

| System Notification: nl SECEEER +
By Device

1
3u4bmsui7tc00000000000@yapmail.com

By Chanrel

» File Management

Verfication
» My Favorite

> Report Analysis

~ Advanced Application

Caliing System

API Widget

System Notification

»  License Management

About

Then you will get notice when your device is under the following situations.

* When the device time can’t sync with the Manager system time, the device can’t play content
normally.

a. It is highly recommended you enable auto time sync service on your device.

b. Make sure to set the same location on both Manager and the device.

[X-Sign System Notice] Unable to play due to unusual device
status

Dexr I

Please kindly be advised that your device(s) with current schedule are in the abnormal
status now and may be not able to play the content correctly.

Device name Category Device status

Rl N S Uncategorized Error - Time Error

Regards,
X-Sign Manager Service Team

BenQ X-Sign



* When the device is under schedule but not online, the device can’t play content normally.

[X-Sign System Notice] Unable to play due to unusual device
status

Dear BenQ,

Please kindly be advised that your device(s) with current schedule are in
the abnormal status now and may be not able to play the content

correctly.

Device Name Category Device status
Uncategorized Offline

Regards,

X-Sign Manager Service Team

* The device license is going to expired.

v
)A X-Sign
Dear I
The following device already expired today:
Device Name Display ID
| =] ]
B e

¢ ignore this email if you think this email does not belong to you

by BenQ

Email sent by
SRS Copyriht © Beng corp. Al rights reserved

* Press == to add more receivers. The default will be the administrator only.

@ System Notification
System Nntificaﬁun:“ SetreEaNER

1
By Channel 3u4bmsu7tc00000000000@yopmail.com

2 Account Management 8, BenQ

By Device

» File Management

Verification

My Favorite

Report Analysis

.

Advanced Application
Calling System
API Widget

System Notification

License Management

About
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v Add emalil

E-mail

Warning Message

Mew email has been added

Updating device status immediately

The pages on X-Sign Manager will automatically do partial refresh if device status changes. Below are
three parts that will do partial refresh automatically:

I. Active status of device: Go to By Device, the online/offline status will be shown automatically on
the page.

P Available space 923 - 1 gax
x o ~S2AccountManagement 8 BenQ @ language g4 i

W - | A dovis o

«

By Device = Add a New Device Add Category X-Sign Player Update
» lar All devices (19)

By Channel
SR [ All devices
Des!gner -
Statu ~ Name Channel Name Device ID Solution
*  File Management s
*  Verification o
RFTVLZZE 0718 RFTVLZZE Basic

» My Favorite

Report Analysis
tomato-nb 12345 Channel UPBSZKV3 Basic
Advanced Application
License Management Premium
4l i
0715 Unsubscribed LAUKCW36 2021.04-27 1201 _
About

& : = i Premium
)‘ X-Sign BRASUIW 12345 Channel BRASU3VV 2021-02-02 06:35.

2. Status of device control: Go to By Device, select the device you want to see the status, and
click %, the online/offline status will be shown automatically on the page.
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3.

Available space 923
GB

B - | A devies

B Ageacs )

By Channel
Designer

*  File Management

* Verification

* My Favorite

' Report Analysis

»  Advanced Application

* License Management

About

Available space : 923
GB

R o | A devicss

By Device
By Channel
Designer ETE)

File Management

Verification

My Favorite

Report Analysis

Advanced Application

License Management

About

«

«

» Bl All devices (19)

Add a New Device

[[] Al devices

Statu
s

Name

RFIVLZZE

m i

W~
)‘ X-Sign SRASUZY

Add Category

o4 Account Management

X-Sign Player Update

Channel Name

0718

12345 Channel

Unsubscribed

12345 Channel

aa Account Management

Device Control ¢ Device Name : RFTVLZZE )

Device status

Device ID

RFTVLZZE

UPBSZKV3

LAUKCW36

BR4SUIW

/_‘@6*

& BenQ @ Language

& BenQ @ Language

Solution

Basic

Basic

Premium
2021-04-27 12:01.

Premium
2021-02-02 06:35...

Al

Offline
(Last Synchronized

20 09:15:32)

Screen

The screen can be tumed on or off manually/automatically for power saving.

Automatic switch mode
On

Schedule downloading progress: Download percentage and result will refresh automatically.

Edit schedule (0715)

Priority

Cycle

High

Day

Week

® Normal

Every

1 Day

Device Name

0715

Device ID

L4UKCW36

Download p
ercentage

1

Download res
ult

downloading

BenQ X-Sign
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Player report (proof-of-play)

|. Go to File List, select a file, and click i .

P Available space | 92.3
GB & Account Management 8 BenQ

N o | File List
By Device [STAEERR)  ( Addfolder ) [ Importfrom Draft ) B e B % u F 2 it

By Channel PPt
Status File name Type Size
= johnny test folder =
- File Management
W 1234567890123456789012345678901234567. folder
File List
Media Library = AprilChiu folder
Download Records W archiveexpress folder
* Verification = old folder Bend 202006-11 183950
* My Favorite
v Exp SKB user1005.1_re 2020-07-29 09:20:45
* Report Analysis
»  Advanced Application
*  License Management ) & i — e
About
v 20200727 Diff 0KB Howard JH Ou 2020-07-27 13:51:05

2. X-Sign records the playback history of each file on each device. Click Export, then the Player
report is exported as an .xls or an .xIsx file type.

File - Player Report wems )
Daterange: | 8 | 2020-07-01 |to | 2 | 2020-07-30 Confirm Search
Device name Play duration ¥ Related schedules Other Events
0715 00:00:41 demo

Using Designer Express

I. All the projects you create with Designer Express will store in the draft list. Media Library,
which store the assets, can accelerate your design. Click New Project to go to the designer
express template editing page.

T e g s
BEIN - | Designer Express Dra
By Device New Pr Add folder rch
By Channel
File name Type Size Updater Updated ¥
Designer 23
& johnny test folder BenQ 34546
> File Management
8 123456769012345678901 234567890123456 7600123456 78801234567..  folder BenQ
> Verification
= 3466666 folder 8en0)
> My Favorite _ .
mET folder 8enQ
> Report Analysis — folder 8en0
> Advanced Application m Aprilchi folder 5en0)
> License Management = Folder folder BenQ
About
): X-Sign New Project(4) op 1k8 Bena
): X-Sign New Project(3) exp 1K8 BenQ
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2. Click Confirm to proceed.

= Designer Express

New Project

1920x108!

Customize Resolution
1920
Panel Area

1

= 1080

Video wall resolution: 1920 X 1080

CONFIRM

3. To add a new page, click +Add Page.

New Project(3)

«—»-

Total Duration: 00:20:00

Page 1

o000 ¥ i

New Page (2)

4. Add an image from Local File for the first page.

New Project(5)

umﬂw-

Page 1

00:10:00 ¥ il

Layer -

© | @object0

Page Property. <

Page 1

00:10:00

Background -

o

#FFF

BN "EER
‘Il "Emn
I A
N TEEn
‘Il A

BenQ X-Sign
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5. Add an image from Media Library for the second page.

New Project(5) New Page (2) v +

- -

© | mObject0

Page Property a

New Page (2)

00:10:00
Background A
W -
o
+

I

6. Save this project in the draft list and submit to File List. Then, just wait for the admin’s approval.

Submit to File List

File List
] 123456789012345678501234567E50123455789012...i
B AprilChiu
B archive-express
B johnny test

= od

Selected ltem
New Project(s)!

7. The project you have just created will show the approval status on File List.

Available space : 923 GB 23 AccountManagement & BenQ @ language 41

BT | Fie s
By Device File upload | Add folder | [ Importfrom Draft | Search Q

By Channel
Status File name Type size Creator Updated ¥
Designer
~ File Management & ): X-Sign :‘;Zwuﬂr?;gt Exp 183K8 BenQ 2020-07-1511:24:48
File List
Media Library
Penioad Recorls v ): X-Sign ?i;“oox - Diff 168MB user1005_1_re 2020-07-06 17:2331
> Verification
> My Favorite
v Express 86 .
v X-Sign Ex 9KB BenQ 2020-07-01 14:18:06 )
» Report Analysis )A 8" 1990x1080 P
> Advanced Application
e anagSnen v ): X-Sign ;ﬁ;%i:f;éﬂ ! &p 101 M8 Beng 20200620 13:42:48
About

8. Then, you can set the schedule with this project.
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Designer

Creating a new project file in X-Sign Designer

In X-Sign Designer you can create your own project with customizable features.

%) X-Sign Designer - New Project - X
File Edit Insert Arrange View Preview Delivery Video Wall Help
Welcome to X-Sign Designer
Please enter your BenQ account first or Start your project now!
* By logging in the account, you can upload content on X-Sign Manager.
— X

%) X-Sign Designer - New Project
File Edit Insert Arrange View Preview Delivery Video Wall Help

Welcome to X-Sign Designer

Please enter your BenQ account first or Start your project now!

:

Password

Forget your password ?
[ Keep login

* You can also use X-Sign Designer without logging in the account by clicking Start now. You cannot
upload content on X-Sign Manager only after logging in the account. Read Uploading your content

from Designer on page 55 for more information.

To create a new project file in X-Sign Designer:
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I. Launch the software and click New project.

File Edit Insert Arrange

Open Project

View

Preview Delivery Video Wall Help

—
HEN
o0
L o HEN
New project New Interactive Project

2. To customize the project settings, configure the following items:

A. Project Location - Select the folder where your project will be saved.

B. Project Name - Create a name for your project.

i

Local delivery

C. Project Orientation and Resolution - Choose the layout and size of your project.

D. Panel Area - Adjust this setting for creating a Video Wall project.

X Close

A - | C:\Users\Michael vokins.tp\Documents |
B Project name | | ||

‘ |© Landscape () Portrait Single display resolution:| 1920x1080 v |

D Panel Area 1 > | X[1 >

Video wall resolution: 1920x1080

Confirm

3. Select Confirm to create the new project file.
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4. To adjust the project settings after a project has been created, click Modify in the Page panel.

%) X-Sign Designer - C:\Users\user\Documents\S\scene.xml — X
File Edit Insert Arrange View Preview Delivery Video Wall Help
*

New Page (1)

Text Image
Video Rectangle
Page -
Name New Page (1)
Duration 00:10:00
Resolution 1920x1080
1920 x 1080 X:-548  Y:-424 -+ 3% - I Panel Area 1x1

5. To import media into your project, click the Image or Video button in the Basic Tool panel.

2 X-Sign Designer - C:\Users\user\Documents\S\scene.xml - X

File Edit Insert Arrange View Preview Delivery Video Wall Help
*

New Page (1)
Basic Tools

Text Image

Video Rectangle
Page v
Name New Page (1)
Duration 00:10:00
Resolution 1920x1080 Modify

1920 x 1080 X:-548  Y:-424 -+ 3% - I Panel Area 1x1

6. Select the media file to import and click Open.

Uploading your content from Designer

With X-Sign Designer, you can directly upload your content to Manager. You don't need to save the
project and upload it separately.

Note:

* You need to have an account on X-Sign Manager. Refer to Registering an account for X-Sign
Manager (Admin) on page 5 for more information.

* Make sure your account has the authority to upload files.
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I. You can also use X-Sign Designer without logging in the account by clicking Start now. You can-
not upload content on X-Sign Manager only after logging in the account.

2 X-Sign Designer - New Project - X

File Edit Insert Arrange View i ry Video Wall Help

Welcome to X-Sign Designer

Please enter your BenQ account first or Start your project now!

GEITED T

2. Press Log in to log in the X-Sign Manager account.

) X-Sign Designer - C:\Users\user\Documents\a\scenexml *

File Edit Insert Arrange View Preview Delivery Video Wall Help
* '

Template

APItemplate - Steak Hous ¢

Chilled & Australian \
Grain Fed o o Y ©

APITemplateRestaurant 19201080 [ Preview Save v

PREMIUM

Player Only

B

odefaultMediaName (Widget)

[}
&

defaultMediaName (Widget)

[}
&

defaultMediaName (Widget)

API template..
1920x1080

T: defaultMediaName (Text Slideshow)

Bank -

[
—

* defaultMediaName (Text Slideshow)

Doutlecick 10 ot nlogin o e comespondingsczout.

©® T defaultMediaName (Text Slideshow)

\
N ¥ ©® T defaultMediaName (Text Slideshow)
BankA 1920x..  BankB 1920x...
1920x1080 1920x1080 ‘ s Ho_usle_ oS F Aafau#MadiaN A maa (laasn)
pecialties
Bar - Property -
Bout Page -
outique - ~
o
- Doutleclick g ut thenlogino e corespndingaccout. Name \Pl-Template-Restaurant 1920x1080
e Ze
ﬂ aY & Duration 00:10:00
—
Boutique-Bag..  BoutiqueBag...
1920x1080 1920x1080 Resolution 1920x1080 Modify
F‘ e -5 { 1920 x 1080 X:-548  Y:-424 - + P37 - 2 Panel Area 1x1

Login
Forget your password ?

[ Keep login
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3.

Once you have successfully logged in, you can see your account information.

%) X-Sign Designer - C\Users\user\Documents\UM\scene.xml * -

Edit Video Wall

Insert

Arrange View Preview

Overview 3

Delivery Help

* Edit mode .
API-Template-Restaurant 1920x1080 [®] preview

Al
PREMIUM

Player Only
Template ‘0

AP| template . ‘Steak HOUS% ® [ odefaultMediaName (Widget)

© [& defaultMediaName (Widget)

Chilled & Australian © [ defaultMediaName (Widget)

ook L__ GCrainFed g : ', © T defaultMediaName (Text Slideshow)
Bank - ® T: defaultMediaName (Text Slideshow)
—'._I [T E———— ©® T defaultMediaName (Text Slideshow)
\ & Baer

© T defaultMediaName (Text Slideshow)

Bank-B
1920x1080 AT Acfai M adiaNamn (lmonn)
Bar v Property
Page
Boutique -
Doubl ik 1og aut. e og i 10 the corespending scount. Douslecick 10g ot then g 1 e companding sccont Name \PI-Template-Restaurant 1920x1080

5 Duration 00:10:00
ﬂ— G.ﬁ

Handbag Sto..  Handbag Sto...
1920x1080 1920x1080

I\ IO

As soon as you finish making the content, press Save and Upload.

%) X-Sign Designer - C:\Users\user\Documents\a\scene.xml
File Edit
¥ »

iz

Resolution 1920x1080 Modify

%]I 1920 x 1080 X:-548  Y:276 -+ 37% - Panel Area 1x1

Insert

Arrange View Preview

Delivery Video Wall Help

API-Template-Restaurant 1920x1080

Save

Save As = ~

Template ] Save and Upload I -

UJ
API template - ‘ Steak House = Export

7 delaunmcuananic (viuyery

ChilSR AL D Sho = defaultMediaName (Widget)

APItemplate...
1920x1080

Grain Fed 3 T: defaultMediaName (Text Slideshow)
Tenderloin (702 / 200gm) 88 -

Ll - T Bone (240z / 750gm) 108 h 3 T: defaultMediaName (Text Slideshow)

B (10 e @ T defaultMediaName (Text Slideshow)

k = T: defaultMediaName (Text Slideshow)
BankA 1920x.. BankB 1920x...

1920x1080 1920x1080 5 dafauthadiaNama (leaana)
e . =4 Y Hungarian Beef Goulash ! Property -
Blue Cheese Burger g
Beef Stroganoof 0 Page -
i = e Burger Daytona
Boutique Ossobucco Gemolata
- Beach Wings O hcken P Name \PI-Template-Restaurant 1920x1080
[ 4= 4"
&> Duration  00:10:00
>

Boutique-Bag..  BoutiqueBag...

5. The file list on Manager will be shown automatically. Choose the path to store the file, then

press Confirm.

File name $ Creator 4 Size 4 Time $

ProductionTest =y
1920x1080 9/11/2019 BenQ 18 Kb 2019-09-11 11:03:04
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6. Designer will automatically upload the file to Manager.

Note: If you want to modify a file, you have to choose the same path and upload the file again.
Designer will only upload the changes rather than the whole file.

7. Only when the administrator approves the file can the file be added to the schedule. Refer to
Setting Verification on page 41 for more information.

Now you can go to X-Sign Manager to schedule your content.

Creating content in X-Sign Designer

Once you have opened a new project, you can begin to customize the content for your project. The
following is an introduction to the basic settings used to create content in X-Sign Designer.

To create content in X-Sign Designer:

I. Click the f' button to open the Basic Tools panel. The Basic Tools panel allows you to add

text, media and shapes to a page. Click on one of the following icons to add a new element to the
canvas:

File  Edit Insert View Video Wall

¥ .

Arrange Prewiew Delivery

UM New Page (1)

Basic Tools

TIA=B

Text Image

=2CclYD

Video Rectangle]

Sle NIF

Oval Line

A. Text — Add a new text box to a page. Double-click on the text box to change the text.

B. Image — Add a new image bounding box to a page. A window will automatically appear to
select an image from your hard drive, then click Open.

C. Video — Add a new video bounding box to a page. A window will automatically appear to
select a video from your hard drive, then click Open.

D. Rectangle — Add a new rectangular bounding box to a page. Adjust the color, border and
shadow in the Content panel.

E. Oval — Add a new circular bounding box to a page. Adjust the color, border and shadow in the
Content panel.

F. Line — Add a new straight line to a page. Adjust the color in the Content panel.
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2. Click the sl button to open the Widgets panel. The Widgets panel allows you to add

specific widgets to a page. Click on one of the following icons to add the respective widget to
the canvas:

File  Edit Insert  Arange View Prewiew  Help  LocalDelivery

*
Edit mode

‘ Storefront New Page (4)
Widgets

S 5

Clock Weather

o w

Video Slideshow | Image Slideshow
==
(O] @

OR Code

=
>
=

2o
B | i

[Tt ol Calling Syste

You

YouTube

F OX

A. Clock — Add a clock to a page. The time is based on your device’s region setting. Adjust the
settings in the Clock panel and the Content panel.

B. Weather — Add a weather forecast to a page. Weather forecast is based on your device’s
region setting. Adjust the settings in the Weather panel and the Content panel.

C. Video Slideshow — Add a new video slideshow to a page. Refer to Creating an Image or
Video slideshow on page 69 for more information.

D. Image Slideshow — Add an image slideshow to a page. Refer to Creating an Image or Video
slideshow on page 69 for more information.

E. QR Code — Add a QR Code to a page to link to an external website. Adjust the settings in
the QR Code panel and the Content panel.

F. Web — Add a website to a page. Adjust the settings in the Web panel and the Content panel.

G. RSS — Add an RSS Feed to a page. Adjust the settings in the RSS panel, the Content panel
and the RSS Config panel.

H. Data Connection — Add a data document to a page. Data is based on a csv document saved
online. Adjust the settings in the Database Connection panel, the Setting panel and the
Content panel.

J. Text Slideshow — Add marquee text to a page. Adjust the settings in the Marquee panel, the
Content panel, the Carousel panel, and the Transition panel.

K. Calling System — Add a waiting number window to a page. A waiting number system can be
created by logging in to your X-Sign Manager account and going to Advanced Application >
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Queuing System. Once created, return to X-Sign Designer and adjust the settings in the
Waiting Number panel and the Content panel.

L. YouTube — Add a YouTube video to a page. Adjust the settings in the YouTube panel and the
Content panel.

M. Timer — Add a timer to a page. Adjust the settings in the Timer panel, the Settings panel
and the Appearance panel.

3. In Edit mode, you can add and customize different pages:

Edit Insert Arrange View Prewiew Help Local Delivery

Va Storefront || Main Page

Basic Toals Specials
Price List
T d
Text Image
i O
Video Rectangle

A. Pages Drop-down menu — Navigate to different pages by selecting ™ at the top of the
canvas.

B. + — Add a new page by clicking on the + Button at the top of the canvas.

4. Click the Overview button to configure the project layout and order.

File Edit Insert Arrange View Prewiew Help Local Delivery
s '

m[ Overview [»] Preview [ save ~ @ Login  ~

Slnre[rn;st Music + = Order L7 interaction
1

01 02

=}
@

|

STRAWBERRY
FESTIVAL

CAKE

I

i 2

Main Page Specials Price List
Repeat 1 time(s) rrmalplayingsimenyss Repeat 1 time(s) [Toralplaymgllmeﬂ:as Repeat 1 time(s) i'rn:alplayingtime 135

5. You can move pages by dragging the page icon to the left or the right.

Edit Insert Arrange = Prewiew Help Local Delivery
'
5 e S
Slnrel{.nsr: Music + = Order ] Interaction
01 4 02
STRAWBERRY S
FESTIVAL = E & & &
- gi] emany e es .
s L T & =
e ] k : — = =
: = —)
Main Page Specials Price List
Repeat 1 time (=) Totalplayingtime 0:45|  Repeat 1 time(s) Total playing time 0:4 Repeat 1 time (s) Total playing time !5
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6. To delete pages, hover your cursor over the page icon and click Delete page. A warning
message will appear, select Confirm to delete the page.

File Edit
3

:

Insert  Arrange

01

‘You worry about ising costs
we koep out rates fued

BankB 1920x1080
Play 00:00:30 ~ | Total playin..00:00:30

View

Preview Video Wall

Delivery

00:02:40

Delete page

Boutique-Bag-1 1920x1080
Play 00:00:40 ~ | Total playin..00:00:40

Help

El Preview @ Save ¥ @ Legin
Music d = Order ] interaction
03 04
STRAWBERRY
FESTIVAL
Dessert-2 1920x1080 Dessert-11920x1080
Play 00:00:45 ~ | Total playin..00:00:45 Play 00:00:45 ~ | Totalplayin..00:00:45

Are you sure to delete this page?

Confirm

Cancel

have the page repeat or change the time duration for a page.

Insert

.

Arrange

Overview

Prewiew Help

Local Delivery

@ Preview

Select ™ on the page icon and click Set Repeat Time(s) or Set Total Playing Time to

@ Save ~ @ Login -

01

STRAWBERRY —
FESTIVAL ‘W\

o

e el

Main Page
Repeat ] time(s) = Total playing time 0:45

Storefront
1:35

Specials
Repeat ] time(s) = Total playing time 0:45

A

Set repeat time(s)

Set total playing time B

S ====3

=N WARCARON=T

Sl e

=oRE BT RE pRINK
Price List

Repeat 1 time(s) - Total playing time 0:05 |

= Order

A. Repeat __ Time(s) — Double-click the number to change the amount of times a page plays.

B. Play 0:00 — Double-click the run time to change the time duration for a page.

insert Arrange

Editmode

Overview

Prewiew Help

Local Delivery

[ﬂ Preview

Click Order or Interaction to choose the play sequence for a project:

Save - @ Login ~

01

STRAWBERRY =
FESTIVAL

it
[or

Main Page
Repeat 1 time(s) Total playing time 0:45

Storefront
1:35

" w w w
s L . &
P S e —
= — -
Specials

Repeat 1 time (s) Total playing time 0:4

Price List
Repeat 1 time(s) Total playing time ! 95

£ Interaction

A B

A. Order — To play all pages in order in a continuous loop, click Order.

B. Interaction — To play a single page or selected pages in a continuous loop, click Interaction.

BenQ X-Sign 6l



9. You can preview your project by clicking the Preview button. This will play the current project
on X-Sign Player. Click ESC to return to X-Sign Designer.

File Edit Insert
75 '

-

01

STRAWBERRY
FESTIVAL

Main Page
Repeat 1 time (s) Total playing time 0:45

Creating content from Designed Templates

Prewiew Help

Local Delivery

Starefront
1:35
02
-l )
S Y -
= | W %
Specials
Repeat 1 time (s) Total playing time 0:4

[El Preview

Music +
03
& ¥E = EE
E if E B
CAKE —=
Shss s e

Price List

Repeat 1 time(s) Totalplaying time ! 95

@ Save ~

= Order

@ Login ~

G interaction

Once you have opened a new project, you can use Designed Templates to quickly generate
content. X-Sign Designer has numerous Designed Templates of varying orientations and
resolutions for the user to easily access.

To create content in X-Sign Designer using a Designed Template:

I. Click the EB button to open a list of templates.

File Edit Insert Arrange View
Template
Bank »
Bar »
Boutique b
Campus -

Campusfilm ...
1920x1080

Campus-sche...
1920x1080

=

Campuwur.. m
1920x1080 1920x1080
Corporation »
Cosmetic »
Dessert »
Exhibition »
Fast Food »
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Prewiew Help

Storefront

Local Delivery

New Page (4)

[ﬂ Preview

Duration

Resolution

Panel Area

Background

Color

Image

Image Style

Transitions

@ Save ¥

[==]

»
New Page (4)
10:00.000
1920x1080 Modify
1x1

#FFFFFF
Add Delete
Fill .



2. Click the drop-down menu for the type of template you want to use and then click icon for the
template you want to use for your project. A new page with the template will automatically be
added to the project and displayed in the canvas window.

Edit Insert Arrange View Prewiew Help Local Delivery

B Storefront New Page (4) = 1

Template
Bank »
Bar »
Boutique »
Campus -

R
¥

Campus-film ... mpus-se...
1920x1080 1920x1080

ot rumnes

Campus-wor.. Campus_sch...
1920x1080 1920x1080

Corporation »
Cosmetic "

Note: The template must match the orientation and resolution of your project settings. To modify
your project settings, refer to Opening an X-Sign |.x project file on page 89 for more information.

3. Alter text in the template by double-clicking the text box in the canvas and typing in your own
text.

Edit Insert Arrange View Prewiew Help Local Delivery
v Hallway 01 Campus-schedule_day 1920x1080 - 4 L Bl |.§, -
Basic Tools Layer -
® i defaultMediaName (Text Slideshow)
T Cad ® I defaultMediaName (Text Slideshow)
Text Image

® Tu defaultMediaName (Text Slideshow)

® T: defaultMediaName (Text Slideshow)

= ) WORKSHOP SERIES,

e fiie Professional And Development Workshops For Studentsg Sep 5 ®:| T detaiitMediuliame \Text Sideshow)

| ® T: defaultMediaName (Text Slideshow)

Progr Courses / Dr. Christina Abrec.,

O y - \ : | Gela binf four of Gur programming courst + @® o defaultMediaName (Text Slideshow)
oval Dasign Colirses M. Karar Popg: T Anfas bk Aadinhaman (ot Clidanhoad
Bl a brief tour of our design cours + fam-ia+ Property ¥
+
Media Courses / Dr. Samuel Wheele + 5300 Text Slideshow 7
Gol 2 briof four of our modia sourse, 4+ 2pm-3pi+
Y Name  defaultMediaName
X 870 - Y 789 I
Width 500 . Height 32
Rotate 0 2

TrANSPa.. —s—ill)
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4. You can replace images or video files by selecting the item in the canvas, then click on the ...
Button in the Content panel. Select your own image or video to insert into the bounding box.

Edit Insert

Edit mode

T P

Text Image

= O

Video Rectangle

&

Oval

WORKSHOP SERIES

Professioral And Development Workshops For Studentsgg

Local Delivery

Campus-schedule_day 1920x1080 - -+

Programming Courses / Dr. Christina Abrec,
Gol a brief tour of our programeming courss +

[El Preview Save ~ @ Logn =

Sep.15,

Get & brisf tour of our deeign cours: +

R207%

Bam-11z +
+

Media Courses / Dr. Samuel Wheele+
Gat & brief tour of our madia courss. -

S30%

Business Courses | Mr. April Huddlestor +'
Gel a brief tour of our business course.  +

LY = -
Layer 8
Property -
Image =

Name defaultMediaName

X oS! v 224 °
Width 640 T  Height 658
Rotate 0 =

Transpa.. ——————--—ou@

Content -
e 3091097189.png D
T one -
e R -
Shadow B

Fixed Ratio »

5. You can customize widget information by selecting the respective widget in the canvas, then
adjust the settings in the Content panel.
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Edit Insert

/
Basic Tools
T Cad
Text Image

> ()

Video Rectangle

O

Oval
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Local Delivery

Campus-schedule_ day 1920x1080 - +

WORKSHOP SERIES

Professional And Development Workshops For Studentsgg

Programming Courses / Dr. Christina Abrec,
Got a brief tour of our programming Courst +

[E Preview Save v @ Logn -

Design Courses | Ms. Karen Popp+

R20%

Bam-fie +
+

Media Courses / Dr. Samuel Wheele+
Get & brief tour of our media courss. -

5301+

Business Courses | Mr. April Huddlestor '
Gel a brief tour of OUr DUSINESS Course. 4

x|=| = -
Layer »
Property -
Weather >

Name defaultMediaName

- -

X 0 B Y 882 _
Transpa.., =

Content v

Display Format ~ Five days (horizontal) =

Color ‘ #FFFFFF

o Sync with X-Sign Manager
(@) Manually Select

Source REPLACE

AQl
Information D



6. You can move objects on a page by selecting on the bounding box in the canvas and dragging it

to the desired location.

Edit Insert Arrange View Prewiew Help Local Delivery

Edit mode [E! Preview Save @ Login -

Va Hallway 01 Campus-schedule_day 1920x1080 - o+ || =
Basic Tools Layer
Property
T Cad Text Slideshow
Text Image

Name defaultMediaName

IAIAMIZALIAR AFEPIES X A0TNS v 139 C
= D YWWUNRNOMUIr"OLNRICY,
Video Rectangle E’mfessinna\ And Developmezﬂt Workshops For Studenls;! Width 1,190 Height 50 =
» Programming Courses / Dr. Christina Abrec.. Rotate 0 B
Q Y i ! Get a brief tour of our programming course +
ol Design Courses | Ms. Karen Popg+ R20% L

Get & brisf tour of our design cours +

Media Courses / Dr. Samuel Wheele+ Content

Get & brisf tour of our media course. -

Business Courses / Mr. April Huddlestor+'
Get a brief lour of our business course. +!

Font Size 46

Font Abel >

T[T VT
Line Spacing 0 =
Character 0 -
Spacing -
Color #FFFDC7

Creating a clock widget in X-Sign Designer

I. In X-Sign Designer, click on the icon Q—) to add a clock widget, and you will be prompted to
place the clock widget.

Insert Arrange View Preview Local Delivery Video Wall Help
: New Page (1) [»] Preview E save ~ @ Login
= % || = -
Widgets

@ object 2 (Clock)

Clock Weather

Clock ¥
Name object 2
X 633 = Y 174 =
Video Sliceshow Image Slideshow
e 2019/01/04 - -
02:47 PM Width 618 S Height 598 3
EE
LS @ Rotate 0 =
QR Code Web
Transpa.., =— @ 100%
i ) -]
Content =
&
RSS Data Connection Format yyyy/MM/dd hh:mm A -
Te
Font Sans Serif -
Text Slideshow  Calling System
| T ||T
‘m‘ (q 1920 x 1080 X:553  ¥:1155 W:618  H:598 - + 42% =~ = =

"
I

2. You can drag the clock widget anywhere in the template.
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3. You may set the properties of the clock widget in the editing area on the right panel.

Clock =

Content -
Name object 2

Format dd/MM/yyyy HH:mm -
X 633 = . 174 S

o SR
Width 618 S Height 598 =

Font Sans Serif -
Rotate 0 .

iy 7 || T

Transpa... & 100%
Content - = = = =
Format dd/MM/yyyy HH:mm - Font Size 44 -

Character 0 -
Font Sans Serif =5 Line Spacing 0 -

Background e

ey T | D

4. You can switch the format of the time/date layout. You can choose to display both the date and
time, or only display either the date or the time.

Video Wall

rrange View

Preview Local Delivery

\ R -
New Page (1) E] Preview verviniia

HH:mm
MM/dd/yyyy
HH-mm
dd/MM/yyyy
HH:mm
yyyy/MM/dd
o hh:mm A
» & " MM/dd/yyyy
Name  Objet phmm A
X 537 dd/MM/yyyy
hh:mm A
& 04/01/2019 & |
17:01 Width 618 HH:mm
Rotate 0  hh:mmA
B = 5 Transpa.. = yyyy/MM/dd
Content | MM/dd/yyyy
Format dd/MM/yyyy
Font Sans Serif -,
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knge View Preview Local Delivery Video Wall Help

New Page (1) [»] Preview Save ~ @ Login

x || g

MM/ dd/yyyy

©@ [ object HH

dd/MM//
- bt

| yyyy/MM/dd
Clock ] hh:mm A
. MM/dd/yyyy
Name  ObJ&( phom o
¢ dd/MM/yyyy
X
54‘. hh:mm A

Width 522 HH:mm

Rotate 0  hhmmA

Transpa.. — YYYY/MM/dd
| ontant MM/dd/yyyy
Format dd/MM/yyyy
o
Font Sans Serif -

Setting a weather widget

. In X-Sign Designer, click on the icon %> to add a weather widget, and you will be prompted to
place the weather widget.

File Edit Insert Arrange View Prewiew Help Local Delivery
CESS
| @ E] New Page (1) = o \‘-3‘(-
Widgets Layer

Property

O & Weather

Clock Weather
M object 1

X -
821 :
Video Slideshow Image Slideshow
Transpa..
EE Content
8 E :

Display Format ~ Tod:

@ Color I:

RSS Data Connection @ Sync with X-Sign b

2. Click on the icon > to add more weather widgets. You can drag the weather widget
anywhere in the template.
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3. You may set the properties of each weather widget. You can set the title layout, text color, and
background color.

- 4+ x N |= -

Layer 3
Property -

Weather v

Name object 1

X 1,148 2 ¥ 386
Transpa... 9
Content S
Display Format ~ Today (vertical) -

CO|Dr _

(® Syncwith X-Sign Manager

O Manually Select

Y O
- + 42% -~ I Brarckoroummd
Background
. Color #CDDBFF
D
1376
4. You can also change the display format.

Layer

Property

Weather Today (vertical)

Harie objet Today (square)

X 5 Today (horizontal)
Three days (vertical)
Transpa.. ==
Three days (horizontal)
Content

Five days (vertical)

Display Format  Five days (horizontal)

Color | #FFFFFF

@ Sync with X-Sign Manager
O Manually Select
5. To set the city, first identify the city in the device management section of the online X-Sign

Manager. You can check Sync with X-Sign Manager to sync the city information with the
device on X-Sign Manager, or you can check Manually Select to select the city yourself.
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Creating an Image or Video slideshow

You can use the Image slideshow or Video slideshow widget to play multiple media files in
succession within one window of the project. The following is an introduction to creating an image

or video slideshow.

To create an image or video slideshow in X-Sign Designer:

I. Click the - button to open the Widget panel and click either the Image slideshow or the

Video slideshow widget.

Edit Insert Arrange

]
Widgets
O o
Clock Weather
Video Slideshow] |Image Slidesh

==
EE2 @

QR Code Web
&
RSS Data Connection

Prewiew

Hallway 01

Help

New Page (4)

Local Delivery

2. A new bounding box will appear in the canvas area. Select the + button on the lower right
corner of the bounding box to add images or videos.

Edit Insert Arrange

=
Widgets
S 5
Clock Weather

Video Slideshow Image Slideshow

==
B El
QR Code Web
&
RSS Data Connection

Prewiew

Hallway 01

Help

New Page (4)

Local Delivery

B0
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-
X Select image file: ﬂ
)

@'&Jv| | <« Dessert » Dessert-11920x1080 » assets - | 5 | | Search assets pel [
Organize + MNew folder = -~ [ @
%l RecentPlaces  ~ |~ - T FESTIVAU i) wellle)l | =
1775444677.png  1988768696.png  2102188116.png  2161050546.png
. Libraries B - —
@ Documents
J’ Music L
Pict 1
e STRAWBERRY! i
B videos 2323358561.png 2438396119.png 3185256865.png I
1% Computer E-’ E ( d =
£, Local Disk (C:) 1 1
= Data (D) (OF: w
5@ BackupData (\N\E [

5 Common (WETA 3323586278.png  353880331png  3572313390.png  3088911961png

58 michael vokins.tt ™ I 2
File name: 2678948725.png - IImageﬁlas (*.jpg *.png *.gif *.b v]
[ Open ] [ Cancel I
> E—

3. Select one or more images or videos to import and click Open.

4. You can resize the slideshow by clicking and dragging on the square nodes of the bounding box.
Edit Insert Arrange View Prewiew Help Local Delivery

Edit mode

—1 Hallway 01 Mew Page (4) - o+
Widgets
Clock Weather
Video Slideshow Image Slideshow
2 ©
=ES
0R Code Web
G
+
RSS Data Connection
|
VI‘E.:!

Text Slideshow Calling System

5. To customize the Image slideshow settings, adjust the following items in the Order panel and
the Transition panel:

A. Image Slideshow Order — Select the image and drag it upwards or downwards to re-order the
slideshow.

B. Add, Replace, Crop, Delete — Select an image to add, replace, crop, and delete.
C. Fill Mode — Select an image to adjust the fill mode. The options include Fit, Fill, Part.
D. Total playing time — Select an image and type in the total playing time.

E. Transition effect — Select a transition effect for the entire slideshow from the menu.
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F. Transition speed — Select a transition speed for the entire slideshow from the menu.

24 X-Sign Designer - C:\Users\user\Documents\S\scene.xml * - X
{0 Edit Inset Amange  View  Preview  Delivery  VideoWall  Help

New Page (3)

[CHE o) image oo
ok Westher Name  object1
x 609 B 191
now widh 901 I Height 524

Education System Comparison Trnspa., @ 100%

o] Average test score in mathematics and scien
2] G} e Average test score in mathematics and science Baciground
nnnnnn web
Color #00000000
order -
& -
Rss A v Micgdapng  ooooss
anipng  oowos
i Caling System
+
i O
Tobe  Timer
C [ Fit -
POF Widget 1 Widget mp =
I Apply toallimages
o D [ www
Vgt
Transition
E LEE s =
TransTion
Very Fast -

6. To customize the Video slideshow settings, adjust the following items in the Order panel and
the Transition panel:

Hallway 01 New Page (4) - o+ LS = -
Layer e

Property -

Video ¥

Order v

T 142545241 mp4 168

; 01050011 MP4 A 13s

g
. B C

. -# x
g = | Delete | Replace |

Transition ¥

Display Time 16.962 D

LY

-

n

A. Video Slideshow Order — Select the video and drag it upwards or downwards to re-order the
slideshow.

B. Delete — Select a video to delete and click the Delete button.

C. Replace — Select a video to replace and click the Replace button.

D. Display Time — Select a video and type in the duration time and press Enter.
Rotating an image or video

The following is an introduction of how to rotate images or video on X-Sign Designer and X-Sign
Player.

To rotate an image on X-Sign Designer:
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I. Click and hold the rotation tab located at the top of an image or video file in a project. Drag to
the left or right and release at the desired degree of rotation.

File  Edit Insert  Arrange  View  Prewiew Help  Local Delivery
i .

Edit mode erview

Vi Storefront Specials - o+ LY & -
Basic Tools Layer -
©® T: defaultMediaName (Text Slideshow)
T Cad © Tu defaultMediaName (Text Slideshow)
©® T: defaultMediaName (Text Slideshow)
© Tu defaultMediaName (Text Slideshow)
B e ©® T: defaultMediaName (Text Slideshow)

© Tu defaultMediaName (Text Slideshow)

© T: defaultMediaName (Text Slideshow)

PR : Tt O

Image 'I

Kano defaultMediaName

X 12805 v 380

Width 320 - Height 320

Rotate 14

Transpa..  s——

2. You can also rotate an image or video by manually changing the value in the Image or Video
panel.

@ Tu defaultMediaName (Text Slideshow)

® T: defaultMediaName (Text Slideshow)

= T dAnfroBbdndinklneen (Taut Chidnnk o

Property v

Image 'I

[ defaultMediaName

X 12807 v 380
Width 320 Height 32000
Rotate 14 -

Transpa., =@

3. You may set the properties in the editing area on the right panel.
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Generating a QR Code

I. In X-Sign Designer, click on the icon EE to add a QR code, and you will be prompted to enter
the URL corresponding to the QR code.

titmoe A
. = New Page (1) - + * ‘ oy | ™ IE
Widgets Layer
® object 1 (QR Code)
O )
Clock Weather
]

Video Slideshow Image Slideshaw

EE
m| =
QR Code Web
Prapeﬂy
QR Code
a
RSS Data Connection Name object 1
X 804 o v 314
a =
: Width 300 T Height 300
Text Slideshow  Calling System
Rotate 0 =
o © 1920 x 1080 X:297  Y:678 W:300  H:300 - 4+ a% . 32
Generate OR Code

Please enter the link address:

http(s)://

Confirm Cancel

2. Click on the icon EE to add more QR codes. You can drag the QR code anywhere in the
template. You can also edit the QR code or the link in the editing area on the right panel.

LS

Layer >

Property -

QR Code -

™ = -

Name object 1

X 804 - v 314 2

Width 300 Height 300

Rotate 0

Transpa...
Content it

Edit Link

QR Code
Analysis

BenQ X-Sign
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Note:
* Each added QR code has its own carousel controls to be edited independently from others.

* QR code can contain up to 256 words.

Adding a data connection

|. Before adding a data connection to BenQ X-Sign Designer, create the data in Google sheets.

=) Movie chart |
File Edit View Insert Format Data Tools Add-ons Help  Allchanges saved in Drive

& e ~ P ONTS % 0 .00 123-  Arial h ol R R BT S AR ROV R FH
—_—

-

1
L

A B C D E = G H
Sunday Monday Tuesday Wednesday Thursday Friday Saturday
8:30~10:30
10:40~12:40

12:50~14:50

15:00~17:00

00|~ ® ;AW N

o

17:10~19:10

i =

19:20~21:20

W

21:30~23:30

[

1
1
1
1
1

@

23:40~01:40

2. Select File and choose Publish to the web.

H File Edit View Insert Format Data Tools Add-ons Help Lasteditwa. ~ Gomments m

Share. . o_ .00 123-  Arial - 10 AU I S v . 4
New .
C D E F G

Open... Cirl+0

1 [ .

2 Rename...

3 Make a copy...

4

- I Moveto...

5 B Move to trash

7 Import...

8

9 Version history >

10

11 Download as -

12 Publish to the web...

13

7 Email collaborators..

Email as attachment

n
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3. Make sure the file is saved in CSV format.

Publish to the web

Make your content visible to anyone by publishing it to the web. You can link to or

embed your document. Learn more

Link

Entire Document 5

» Published conter

Web page

Comma-separated values (.csv)
Tab-separated values ( tsv)
PDF document ( pdf)

Microsoft Excel (. xlsx)

OpenDocument spreadsheet (.ods)

Note: It may take about five minutes for Google data to synchronize with X-Sign Designer.

4. Click on the icon f.}@ to add a data connection, and you will be prompted to enter the Input
Web URL corresponding to the data in Google sheets. Then enter the information for the
column, row, and update frequency. You can create the data connection with one single table
instead of creating a cell one by one.

Data Connection settings

Source URL:

htip://

Column From:

Row From:

Update Freq: 600

1 Column To: 10 *1~10

1 Row Ta: 10 *1~10
Secs

Confirm Cancel
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Setting a timer widget

I. In X-Sign Designer, click on the icon @ to add a timer widget, and you will be prompted to
place the timer widget.

Insert Arrange View Prewiew Help Local Delivery

= 3 | NewPage(n) -+ x [N
Widgets Layer
S o Property
Clock Weather
Page
New Pz
Name =
Video Slideshow Image Slideshow Duration 10:00.C
mE @ Resolution 1920x1
D%
QR Code Web Panel Area 1x1
Background
&
R3S Data Connection Colar
Image
Ta M
Text Slideshow Calling System
Image Style Non
You @
Transitions
YouTube Timer
1920 x 1080 X:1528 Y:1272 - + 4% =~ o

[ [P

2. You can drag the timer widget anywhere in the template.

3. You may set the properties of the timer widget in the editing area on the right panel. You can
switch the count mode to Countdown and Count up. You can also switch mode to Calendar
Mode and Repeat Mode.

Settings = Settings -
Function Countdown - Function Count up =
Mode Calendar Mode b Mode Repeat Mode w
Strtbate | 2018/03/26 | SortDate | 2018/03/26 |
Start Time 08:00 hd Start Time 08:00 hd
EdDate | 2018/03/26 | EndDate | 2018/03/26 |
End Time 08:30 i End Time 08:30 3
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4. Countdown shows a sequence of backward counting to
your scheduled end time.

5. With Calendar Mode, you can select start time and end time.

Settings

Function

Mode

Start Date

Start Time

End Date

End Time

Appearance

indicate the time remaining before

Countdown x
Calendar Mode >
| 2018/04/20 |
12:00 s
| 2018/04/20 |
12:30 s

start time or end time button. Click Confirm to finish setting.

Sun Mon Tue Wed Thu

and end time repeatedly.

<

April 2018

Confirm

Cancel

>
Fri  Sat
[ 7
13 14

Settings

Function

Mode

Start Time

End Time

Open calendar by clicking the

Layer

Property

Rotate 0

—_—

Transpa
Settings
Countdown

Function

Mode Calendar Mode

surtpare | | 2018/04/20

Start Time 12:00

2018/04/20

End Date | |

End Time 12:30

Count up -
Repeat Mode -
| 2018/04/20 |
12:00 b
| 2018/04/20 |
12:30 b

BenQ X-Sign

Countup shows the adding of time. It starts at 0:0 (minutes: seconds) and counts up to your
scheduled end time. With Repeat Mode, the counting will occur everyday between the start

77



7. You can change the display format (Minutes/Seconds or Minutes) and layout (A or B).

Appearance

Display Format ~ Minutes/Seconds

Layout Layout A

Settings

Appearance

Display Format ~ Minutes

Layout Layout B
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Creating an APl template using the demo kit

I. In X-Sign Designer, click on the icon to add an API widget, and you will be prompted to

select the name of the API table(s) you have created in X-Sign Manager. See Creating an API table
in X-Sign Manager on page 38 for more information.

Arrange View

Preview

Local Delivery

Video Wall

Help

New Page (1)

RSS

Ta

Taxt Slideshow

You

YouTube

PDF Widget

TV Input

2. You can drag the API widget anywhere in the template.

Edit

Edit mode

Ta

Text Slideshow

You

YouTube

PDF Widget

Gl

Data Connection

Calling System

5]

Timer

=]

Widget

1920 x 1080 X.938

Y¥:193

New table_1

Confirm

Cancel

Page

Name

Duration

Resolution

Panel Area

Transition

Insert Arrange View

&

Data Connection

Calling System

S

Timer

=]

Widget

Preview

Local Delivery

Video Wall

Help

New Page (1)

CounterPrijs
00
120
160
no

300

!

361 43bdS0HSTIBCTTebe kI3 34e

HTMLElementdD

2061130394 5OR508081 e3bTAIG0
62b87cf5d7464 behaSand 22al eacOfad
T10c19F4fhh3433ea2222d8 a5ddT5e5

edrddo] 143414876800fh34351c 34604

s

New Page (1)
10:00.000
1920x1080 Mo

x1

” Show table hea

MNumber Format

Mumber 1,000

Currency ¥
.0

Content

w
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3. You can resize the table by double-clicking the table. An editing window will pop up. You can
change the current column width or all row height.

o i
Resize Table Current column width: 300  © Allrow height: 60 = ‘
3361133bd60443758cfff7eb68f3
600
734e
220 ae0el1130df394c598508a081e3b
! 78960
62b87cf5d7464beba5aad422ale
160
ae0fal
| 210 710c19f4fbb8433ea2222d8fa5d
d75e5
200 ededde]143414876800fb34351c [
346¢4 |

CONFIRM  CANCEL

4. You may set the properties of the APl widget in the editing area on the right panel.

Edit Insert Arrange View Preview Local Delivery Video Wall Help

T
New Page (1)

Widget »

@ j: Series -~
RSS Data Connectior -
CounterPrijs HTMLElementiD Choose series
o TS e———
. = O ———— @i show table header
Ta
i 160 62b87cf5d7464bebasant22a] cachfad
Text Slideshow Calling System Number Format
210 T10c19F4fbb8433ca2222dB a5ded 75e5
300 ededde] 1434148768006 3435 134604 S Choose data
You
 Tube| = Number 1,000.12 -
YouTube Timer
Curency ¥ =
< «.0 0.» « v
B ® : Sl
PDF Widget Widget Content -
ﬂ Font Serif =
TV Input

1920 x 1080 X:-355 ¥:228 W:799 H:404 -+ 4% -
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5. Click Choose data to arrange the data format.

Edit Insert
.

Edit mode

Arrange

Overview

Preview Video Wall Help

Local Delivery

View

New Page (1)

Choose the format and click Confirm.

(] Preview [ save - @ vLogin

WJkills
Widgets \m -
_te - I
QR Code Web . ;
Widget »
& seres .
i Pete Grmpeciion CounterPrijs 'J-‘ HIMLElementiD Choose series
. : j::iﬁ::kzm::; @ show table header
’I“l 160 62b87c3d7464be baSaad22aleaedfall NomLo Forat =
Text Slideshow Calling System s BT Tt
00 edodde] 1434148768001b343 5134604 Choose data
@ i Mumber ,000.12 -
YouTube Timer
@ .0 0.+ s $
PDFﬂgal Widget Content -
H Font Serif x
Pies 1920 x 1080 X:-355 Y:-228 w:799 H:404 - + 4% -
Data
CounterPrijs
HTMLElementID
6. You can edit number and currency under Number Format.
Number Format - Number Format -
CounterPrijs Choose data CounterPrijs Choose data
100012 Number 1,000.12 -
Currency 1,000.12 ¥
1.000,12 8
Content - Content W
Color #000000 Color £
Font Serif - Font €

7. You can choose to display the table header by setting Show table header to on.
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8. After setting the format and properties, you will see the changed outline.

Video Wall

View

hrrange Preview  Local Delivery

Help

| Mew Page (1) - + m Preview Save ¥ @ albertkang

iy aile

PREMIUM
ty
) object 1 (Widget)

l

= -
=

Content

Color

Font Calibri ¥

-
~
I~

I
L]
I
I

Font Size 37 -

Character ~
Spacing

Line Spacing o -

Table

Background
color

Border color

Border width 1 -~
1920 x 1080 X:1224  ¥Y:1224 W:1634 H:473 - + 42% - 3

9. You can also add another API table to the existing template.

82

rrange View  Preview  LocalDelivery  VideoWall  Help

New Page (1) @ albertkang

%= e -

(o] object 2 (Widget)

@ [& object1(Widget)

- S I

| 1295 Dragon Roll o Color #005500
Font
2995 MERRY WINTER BOX
o 5] 0o i | 7' (| T
Font Size 35 -
19201080 X:2351  Y:900 W:818  H:471 -+ 4% - B
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Creating a TV Input source widget in X-Sign Designer

place the TV Input widget. The TV Input source is transmitted through an HDMI cable.

Edit Insert Arrange View Preview Local Delivery Video Wall Help
'

Edit mode

Program 1

Save = @ Login

In X-Sign Designer, click on the icon i toadda TV Input widget, and you will be prompted to

—_ 8%

PDF Widget Widget

TV Input

&
RSS Data Connection
! TV Input
Ta :
Text Slideshow  Calling System Name CH1
X 376 5 Y 113
You
(i3] "
Width 949 & Height 747
YouTube Timer
Transpa...
or
_________________________________________________________|

1920 x 1080 X:1806  Y:1287

W:949  H:747 - + 3/ -

2.

You can drag the clock widget anywhere in the template.
3.

You may set the properties of the TV Input widget in the editing area on the right panel.

] Preview Save ~ @ Login

‘\|"W"" i'

= (e

TV Input

Name  CH1
b 376 = R 113
Width 949

Height 747

Transpa..  e—— 80%

Setting background music in X-Sign Designer

Once you have completed a project, you can add a music file to play in the background when the

project is displayed. The following is an introduction to adding music to the background of a project.

To add music to a single page in X-Sign Designer:
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I. While the project is in Edit Mode, go to the Audio panel and toggle the With Background

Audio switch to the on position.
Edit Insert Arrange  View Prewiew Help Local Delivery

) v -

Vi Storefront Price List - + L = IIE—'l .
Basic Tools Layer »
Property ¥
T Cad Page v
Text Image Background L4
Transitions v
= O o |
= ect one >
Video Rectangle B 80 n .n
Qoo
s Duratior Normal g
7000 {+]

Background Audio -
flavor +! flpcd+Binc+ flavor + dpei+Binc+

Oval
r 41 Cheese cake + 80 +580+ Napoleons + 80 +580+
A e d m Cupcake + 80 +690+ Mango mousse + 90 + :690 + I Wwith Backaground Audio
M 'y Chaocolate cake + 80 +680+ Chiffon cake + BD +6B0+
= Lemon roulade + 100+700+ Cheese cake + 100+700+
AKE

Source

Note: Make sure no bounding boxes are selected in the canvas in order to access the Audio panel.

2. Select the ... Button to import a music file. Choose the mp3 file from your hard drive and click
Open.

-+ % |5 = -
Layer »
Property -
Page r
Background »
Transitions v
50 E5A0E Effect None =
1 Duration Normal b
Background Audio -
+ lpci+Binc+ flavor + 1pcetbing +
® + BO +580+ Napoleons + B0 +580+
+/ 80 4690+ Mango mousse + 90 +690 + @ With Background Audio
cake + BD +680+ Chiffon cake  + BO +6B0+
lade + 100+700+ Cheese cake + 1004700+
Source
(.. 1
| oo m -
+ B0 +130+ — '
. @ll+‘].40¢- s o _‘:‘
100160+
e DRINK Volume &

Mute )

Loop &
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" %) Select file: (o

@O-\ ).« MIKESFX » SI6000 Series » CD G001 - [ 43| search cD 6001 2|
QOrganize * New folder =~ [ @
& Music “ Name & Tite Contributing artist *
[E5] Pictures |#] Track 19.mp3 19 Track 19 Sound Ideas
B Videos 2] Track 20.mp3 20 Track20 Sound Ideas
|| Track 21.mp3 21 Track 21 Sound Ideas
/% Computer |&] Track 22.mp3 2 Track 22 Sound Ideas
ﬁ Local Disk (C:) || Track 23.mp3 3 Track 23 Sound Ideas H
s Data (Dy) | Track 24.mp3 24 Track 24 Sound Ideas
#® BackupData (\\E7 || Track 25.mp3 35 Track 25 Sound [deas
5# Common (META || Track 26.mp3 26 Track 26 Sound Ideas
5 michaelvokins.ty || Track 27.mp3 27 Track 27 Sound Ideas
5 Case (\ETA-File- || Track 28.mp3 28 Track 28 Sound Ideas
58 Client (\WETA-File || Track 29.mp3 29 Track 29 Sound Ideas
5 Remote_lob (WE' |4 Track 30.mp3 30 Track 30 Sound Ideas -
4 Temo META-File ™ | I | ’
File name: Track 20.mp3 v [ Music file (mp3) -
[

3. You can adjust Volume in the Audio panel.

e % || = .
Layer »
Property -
Page v
Background *
Transitions o
o Effect None >
Duration Normal -
_ Background Audio -
+ [pcd+Binc+ flavor + Ipce+Bing+
ke + B0 <580+ Napoleons. + 80 +580+
+ 80 - 690« Mango mousse + 90 +690+ @@ vith Background Audio
cake + 80 4680+ Chiffon cake  + 80 +/680+
ulade + 100+700+ Cheese cake + 100+700+
Source
Volume @o———— %

'ﬂ @@ Repeatinfinitely

AN e T

To add music to an entire project in X-Sign Designer:

[. While the project is in Overview Mode, click the music button at the top of the canvas.

File Edit Insert Arrange View Preview Delivery Video Wall Help

¥ '

* Overview El Preview @ Save ¥ @ Login
00: mli:g Music =" Order L7 interaction

01 02 03
Greatl }
Ethereal Way v
STRAWBERRY
‘ ?\ & 3 FESTIVAL
Lk
Boutique-Shoes 1920x1080 Dessert-1 1920x1080 Dessert-2 1920x1080
Play 00:00:18 ~ | Total playin..00:00:18 Play 00:00:45 ~ | Total playin..00:00:45 Play 00:00:45 ~ | Total playin..00:00:45
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2. Choose the mp3 file from your hard drive and click Open.

o
X Add music M
@i iv|].« - — - v“,| Search CD 6001 ,O|
Organize « Mew folder =« [ ®
& Downloads * MName . £ Title Contributing artist =
5] Recent Places |4 IracklZ.mps 12 Irack 12 Sound ldeas
14| Track13.mp3 12 Track13 Sound Ideas
= Libraries 14 Track14.mp3 14 Track14 Sound Ideas
@ Documents || Track15.mp3 15 Track15 Sound Ideas E
J; Music 14| Track16.mp3 16 Track16 Sound Ideas
[ Pictures & Track 17.mp3 17 Track17 Sound Ideas
B videos |4 Track18.mp3 18 Track 18 Sound Ideas
|| Track19.mp3 19 Track19 Sound Ideas
1M Computer | 14| Track 20.mp3 20 Track 20 Sound Ideas
a Local Disk (C:) ¢ Track 21.mp3 pa | Track 21 Sound Ideas
 Data (D¥) |4 Track 22.mp3 22 Track 22 Sound Ideas
@ BackupData [W\E || Track 23.mp3 23 Track 23 Sound Ideas -
&3 Common META ™ ¢ | I I ’
File name: Track 20.mp3 [ Music ile (.mp3) v
I Open I [ Cancel ]
- ]

3. You can replace or delete the mp3 file by selecting the following:

File Edit Insert Arrange View Preview Delivery Video Wall Help

¥ '

¥ Overview E Preview
um
S48 ‘ OrelSan - Basique [C =" Order L Interaction

01 02 03

Gireatly ?
Ethereal Way
STRAWBERRY
‘ ?L \ 3 FESTIVAL
CH
Boutique-Shoes 1920x1080 Dessert-1 1920x1080 Dessert-2 1920x1080
Play 00:00:18 ~ | Total playin..00:00:18 Play 00:00:45 ~ | Total playin..00:00:45 Play 00:00:45 ~ | Total playin..00:00:45

A. Replace - You can replace the audio file by clicking on the file name and selecting another file
from your hard drive.

B. Delete - You can delete the audio file by selecting the trash icon.
Note: The audio file will play on a continuous loop for the entire duration of all the pages.
Changing the playing order of pages

Once all your project pages are completed in X-Sign Designer you can change the playing order for
the final content.

To change the page order of a project:
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I. Select the Overview button to see the page layout of the project, the order page icons repre-
sent the playing order for the project.

File Edit Insert Arrange View Preview Delivery Video Wall Help

’

*

* [ Overview m Preview Save ~
um . L ] —
00:01:48 Orelsan - Basique [C... [[]] =" Order G Interaction
01 02 03
2
STRAWBERRY
FESTIVAL e
»
Ut
Boutique-Shoes 1920x1080 Dessert-1 1920x1080 Dessert-2 1920x1080
Play 00:00:18 ~ ‘ Total playin...00:00:18 Play 00:00:45 ~ | Total playin..00:00:45 Play 00:00:45 ~ ‘ Total playin...00:00:45

2. Select the page icon you want to move and drag it left or right to the desired position.

Prewiew Help Local Delivery

[El Preview @ Save = @ Login =

Sioref;;n; Track 21.mp3 [le- =" Repeat L] RepeatOne

01 02 03

STRAWBERRY r -
FESTIVAL E d ke, o
=R 0y, w3 ww W
- ﬁ =D
& ""‘E E’ E.v
Main Page Specials Price List

Repeat 1 time () Total playing time 0:45 Repeat 1 time (%) ‘Tmal playing time 0:45 Repeat 1 time (%) |Totalplayingtime( 15

Encrypting a project in X-Sign Designer

You can encrypt your project using X-Sign Designer. The main purpose of project encryption is to
prevent others from playing your file.

To encrypt a project in X-Sign Designer:
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|. Go to File > Encrypt Project.

File

View Preview Video Wall

Edit Insert Arrange Delivery Help

New Project CtrN

view
New Page (1)

Open Project Ctr+0

New Interactive Project

Save cirhs
Saveas..

Upload to Manager
Export

Encrypt Project

Quit

O 1~

oval Line

2. Select the file you want to encrypt. Enter six-digit code as your verification code, then click
Confirm.

Encrypt Project

Enable sealing feature to enhance the security and privacy of
your project during playback.

|+ Enable encryption code protection

Please enter 6-digit private code as encryption code.

] e

Close

Note: Use numbers (0-9) or upper and lowercase alphabets (A-Z, a-z) only. Special characters (-
)(-)(Q) are unacceptable.

88 BenQ X-Sign



3. You can have your encrypted project delivered in X-Sign Player using Local Delivery or
Standalone(USB).

File Edit Insert Arrange View Preview Delivery Video Wall

Help

"
Local Delivery

Standalone(USB)

Basic Tools

T (d

Text Image

4. For more information about playing encrypted projects, please refer to Playing encrypted projects

on X-Sign Player on page 101.

Opening an X-Sign |.x project file

X-Sign Designer 2.x can open projects created in X-Sign Designer |.x.The following is an
introduction of opening and saving an X-Sign Designer |.x file.

To open an X-Sign Designer |.x project:

I. Launch the X-Sign Designer software and click Open Project (You can also select File > Open

Project or Ctrl + O).

File Edit Insert Arrange View Prewiew Help Local Delivery

iz

.

Open Project New project New Interactive Project Local delivery

Demo Video
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2. Click Browse your folder. Locate the |.x project file on your hard drive and click Open.

0 Recent Mission

X-Sign Cloud

B Browse your folder

{ X Close )

8 Computer

&L, Local Disk (C)
s Data (D:)

G BackupData (\\E
&8 Common (\\ETA
S michael.vokins.g
£ Case (\ETA-File-
9 Client (\WETA-File

%) Select ¥-Sign Project: ===
@@vl ], « BENQ » x5ign20 b Source b [ 49| [ Search Source |
Organize v Mew folder = O @

4 Documents ~ * Name Date modified Type
&' Music
e || %-Sign 1.6 files 02/03/2018 440 PV File folder
|| Pictures
B v || %-Sign 20 introduction 15/03/2018 1125 ... Filefolder
ideos I
|| X-Sign 2.0_UM_20180130_EN peff 02/03/2018 441 PM  File folder
|| X-Sign Software 2.0 and password 05/02/2018 514 PM  File folder

£ Remote JobME ™ ¢ | A

File name:

+  [-Sian Projects (scencxmlyas ~
Open Cancel

3. Once opened in X-Designer, X-Designer |.x project files will be automatically saved to a 2.x
project file. To save the project as an X-Sign Designer 2.x file, click either the Save or Save As
button in the top right corner (You can also select File > Save or File > Save As).

Save As

Layer

Save and Upload

& (T) CUETE T ST T TTHE LA

Rename the project and choose the location on your hard drive, then select Save.

Organize » New folder gz - @
¢ Favorites Documents library B e Fokde -
Bl Desktop Iwcury
i Downloads 3 MName Date modified Type
| Recent Places
|| assets 07/02/2018 3:00 PM  File folder
= Libraries . data 07/02/2018 3:00 PM  File folder
|=] Documents T assetsoml 08/02/2018 3:32 PM XML Documen
J} Music ’i scenexml| 08/02/2018 3:32 PM XML Documen
[ Pictures Eﬁ Preview.png 08/02/2018 3:32 PM  PNG Image
B2 Videos |%| storage.db 07/02/2018 3:29 PM  Data Base File
- * 4 1 ] »
File name: Sterefront_luly e
Save as type: [(All Files () vl
= Hide Folders [ Save ] l Cancel ]

Changing your language in X-Sign Designer

I. Open your X-Sign Designer, then click Help.

2. Scroll down and click Language.
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3. Choose your language from the language menu.

2 X-Sign Designer - C:\Users\user\Documents\a\scenexml - O X

File Edit Insert Arrange View Preview Delivery Video Wall Help
0 '

About
Edit mode 9 [ Preview Save ~
APITemplateR
2 MPIAIERES  Check for Updates
(az] Quick Help

Template Quick Guide for Interactive Template Layer v
APl template . Quick Guide for API Widget . ©® % odefaultMediaName (Widget)
English ne (Widget)
Language >
. D LIS ne (Widget)
Server Location
Restaurant O zaesx )
19201080 ne (Text Slideshow)
[] Deutsch
Bank - ne (Text Slideshow)
[J Nederlands
TETTT—
. p .8 [] Francais ne (Text Slideshow)
;».LA — ,.} AliTime [ Polski ne (Text Slideshow)
ank- ankt
1920x1080 1920x1080 Favourite [ Espafol OV
l <
Bar " [J pycckuin
Boutique - [ Cestina
- Doutie ko g ot hen ogn o e conesponding scount. Dousle ko1 ot henlog o the corspending scount. . Ite-Restaurant 1920x1080
£ gl Z4 [J taliano | —————
& m=ES
—
Handbag Sto..  Handbag St "
Herdbag o~ Handbag e O #=2o b
., [ Portugués

»

! I 1920 x 1080 X:1192  Y:1301 - + 37%
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Player

Switching the mode of Player

There are three modes for Player to play the content:

*  Standalone (USB): Directly play the content from USB.

X-Sign Player

X-Sign Designer

X

* Display the content
¢ Interact with the end
customers

*  Design the Content
¢ Save the content to the USB

*  Local Delivery (need the license): Play the content from Designer connected in the same subunit

with Player.

X-Sign Designer X-Sign Player

%

* Display the content
Interact with the end
customers

¢ Design the Content
* Deliver the Content

*  Manager (need the license): Play the content from Internet. Player has to pair with Manager.

X-Sign Designer X-Sign Manager X-Sign Player

‘7]

2

* Design the Content ¢ Schedule the content Display the content
* Upload the Content *  Control the device Interact with the end
Monitor the status customers
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I. Press Esc button on Windows Player or MENU on BenQ Smart Signage remote controller to see
the menu bar.

a Settings

oG Switch Mode

o About

B aut

2. Choose Switch Mode.

== PlayfromFile

o Settings

o4 Switch Mode

© rbout

[,‘-» Quit

3. Select the mode you want to play the content.

Playing files with USB

In X-Sign Player, for standalone function you can play files with your local storage or everywhere with
your USB. The file in the USB can be played automatically once the USB is connected to the device.
Set the auto play to off if you want to select specific files. The following is an introduction of how to
play file from USB.
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How to pack .xplan file

* Standalone(USB)

I. For Standalone(USB), fill in the schedule name, choose the project you want to play in the schedule and
select the start and end time. Press Save to continue.

Edit Schedule

Selerle G Test_0821_sealing fe

Deliver File Test_0821_sealing fea-- Browse

Time | All Day

Start 09:35

End 16:00|

Remove

2. Select Standalone(USB) to play the file.

Schedule

Add Schedule Standalone(USB)

B3 Standalone(USB)

12pm
01pm
02pm
03pm
04pm

05pm

If you want to use Play from File to display your content, you should turn off Plug in USB and
play automatically in Standalone mode first. Therefore, Play from File will show on the menu.
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|. Tab the menu bar again, and press Play from File.

Play from File

[ g

Settings

Switch Mode

About

Quit

2. Keep pressing Back to go back to the root folder. Then go to the "mnt" folder.

Selext X-Sign playable file:

Play

lib mnt mslib proc
root sbin sdcard selinux
storage sys system tmp
Close

BenQ X-Sign
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3. Select the "usb_storage

Selext X-Sign playable file:

O

asec

(.

sdcard

4. Choose the file you want to play, then press Play.

Selext X-Sign playable file:

6

Android

" folder.

I1so

B

secure

DemoRoom_IL.xplan

O

System Volume
Information

interactive template.xplan

5. Now you can enjoy your content.

obb

shell

Close

-

LOST.DIR

interactive_potrait.xplan

Close

Play

o

samba

(]

usb_storage

)

Snow Mountain

-

Note: Once you play files successfully, the path will be remembered. You don't have to choose the

path again next time you pl

ay files.

While turn on Plug in USB and play automatically in Standalone mode, you can play content
with your USB. Please be noted that if USB contains both .xplan files and other media files, X-Sign
Player will play .xplan files. However, if you would like to play media files, you need to delete .xplan
files from your USB to ensure your USB only contains media files which you would like to play.
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USB autoplay

Watch demonstration video:

If you would like to play the latest .xplan file automatically, please turn on Plug in USB and play
automatically in Standalone mode.

If you would like to play the media files in the root folder of your usb automatically, please turn on
Plug in USB and play automatically in Standalone mode and make sure your USB doesn’t
contain any .xplan files. Please delete .xplan files from your USB to ensure your USB only contains
media files which you would like to play.

Note: X-Sign Player can read and play the media files in the root folder of USB. Only X-Sign Player (Android, iOS,
Windows) version 2.6 and above support this function.

To use USB autoplay, switch to Standalone(USB) mode and open the toggle Plug in USB and
play automatically.

Standalone

Activation

@ standalone
Verification code Disabled
Local Delivery
And Interactive
(Pairing...) Play encrypted only (Standalone mode)
Plug in USB and play automatically. .
Manager
Mode Description
Close
* Play Rules
ltem Supported format
Image duration 5 seconds
Supported Image format .jpeg, -jpg, -png, -gif, .bmp, .svg
Video duration Depends on video length
Supported Video format .avi, .mp4, .m4v, .rmvb, .mov, .mkv, .mpg, .3gp, .webm
Play order Alphabetical order
Maximum play items 30 (including images and videos)
Priority of Standalone(USB) | .xplan > media files
features

» Specific rules for BenQ Smart Signage
I. 811 platform (SL4302K, SL5502K, SL6502K): USB autoplay supports 4K videos
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2. Non-81 | platform: USB autoplay doesn’t support 4K videos; special 4K is incompatible with USB
autoplay.

Note: the codec limitation on each platform can be found on BenQ eSupport.
Activating an Interactive function in Standalone mode

You can activate your license both in Standalone mode and Local Delivery mode.

* Activate license in Standalone mode:

|. Choose Standalone > Activation.

Standalone

Activation

& standalone

Verification code Disabled
Local Delivery
And Interactive
(Pairing...) Play encrypted only (Standalone mode)

Plug in USB and play automatically. .

Manager

Mode Description

Close

2. Here you can find the Activation Code.

Switch Mode

Standalone

Activation Code

Playing Status

Close

* Activate license in Local Delivery mode:
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|. Choose Local Delivery > Activation.

Switch Mode

Local Delivery And Interactive

Activation

o Standalone

Verification code Disabled

Local Delivery
And Interactive
(Pairing...)

Mode Description

Free trial for interactive feature

Manager

Close

2. Here you can find the Activation Code.

Switch Mode

Local Delivery And Interactive

Activation Code

Playing Status

Close

Once you have purchased an Standalone Premium License, you can configure your device. The
following is an introduction for activating an Interactive License in X-Sign Player.

To activate your standalone premium license in X-Sign Player:
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I. Select unpaired licenses, then click Mapping.

Avalable space - 100
B

Broadcast

By Device
By Channel

» File Management

> Verification

> My Favorite

> Report Analysis

> Advanced Application

- License Management
| License List
License Extension
History and Seting

About

AccountManagement 8, BenQ @ Lanquage 4’

License List

Status. Device Name Device D pack Type Activated on ExpirationDate  License Code Mapping

Expired Premium O¥ear30Day 170112231 20170214075,  ACMARUFVM2XG23AH

Expired Premium O¥ear30Day 170112231, 20170214075, ACMSZBHTCX2UH

Expired Premium OVear3Day 20174 2017:0214075...  ACMVAUMB3P54333A

Expired Premium OVear3Day 20174 2017:0214075..  ACMX4Q3MIBAUV2NA

Expired Premium O¥ear30Day 2017.01- 2017:0214075..  ACM3HICMULSRV42C

Used HRSLB23V HRSLB23V Premium 3Vear 201000111018, 2022.09-11 10:18... AC 3

New Premium 3Vear Mapping

New Premium 3ear Mapping

2. After mapping licenses, fill in the activation code which shows on your X-Sign Player, then click
Finish to complete pairing.

Avalable space 100 5
% Account Management  $ BenQ @ Language

By Device

By Channel

File Management
> Verfication

> My Favorte

» ReportAnaysis

» Advanced Application
* License Management

About

3. Choose Switch Mode.

Play from File

O Al devices (1)

£ settings
O Switch Mode
@ Avout
P it

100 BenQ X-Sign

Add a New Device

R— | |
“License Code Pairing ACPISV33GDHB3Y2) e
—
S
Category Uncategorized al
Channel Unsubscribed M
Description vithin 150 characters




4. When the pairing is done on X-Sign Manager, you can start to set schedules
Standalone(USB) mode or Local Delivery mode.

Switch Mode

Standalone(USB)

Local Delivery
And Interactive feature
(Pairing...)

o Manager

5. On the Local Delivery page, you can see that the device’s license has been paired.

Paired
The source of content is from Manager.

Device ID: SGBLRDZV
Device Name: UM

Playing encrypted projects on X-Sign Player

. Set schedules with

Close

Once you have sealed the file in X-Sign Designer, you can play the file in X-Sign Player following the

steps below.

[. Select Settings.

o Settings

O  Switch Mode

o About

E" Quit

BenQ X-Sign
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2. Go to Verification code to enter the six-digit code. Click Save to continue.

Settings
Orientation Default
Verificationcode e
Play encrypted only (Standalone mode) )
Update

Update History
Clear all contents

Reset and clear all data

Set Verification Code

¥ Enable Verification code

1[2[3]4[s5]s

*Letter or digit only

+ Show \exificatian code

Save

3. Go to Play from File to select the sealed file. Once the verification code is set in X-Sign Player,
the sealed file can be played successfully.

Play from File

O Settings

¢ Switch Mode

© About

E’ Quit
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4. If the verification code is not set in X-Sign Player, the encrypted project cannot be played. A
notification will kindly pop up: “Load failed because of broken seal.” To have the notification
work, go to Settings and set System notification to on. The notification function is off by
default.

Settings

System notification ®

Auto-launch after startup )

Orientation Default

Verificationcode e
Play encrypted only (Standalone mode) ®
Update

Update History

Close

Changing Picture Settings in X-Sign Player (SL4302K/L5502K/SL6502K/SL7502K/
SL8502K)

This feature only works on SL4302K/L5502K/SL6502K/SL7502K/SL8502K. To change Picture Settings
in X-Sign Player, select Picture Settings.
L3 setnos

B o
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Picture Settings

Picture Mode o Custom

Brightness

Contrast

Saturation

Color Temperature Standard

|

Menu Description

Picture M . . .
cture Mode Press n / u on the remote control to adjust the picture mode. Options are
PANTONE® Color, M-Book, Cinema, Photo, Custom.
Brightn . . .
ghtness Press n / n on the remote control to adjust the brightness. This feature only
works under Custom in Picture Mode.
ntr. . .
Contrast Press n / u on the remote control to adjust the contrast. This feature only
works under Custom in Picture Mode.
Saturation Press n / u on the remote control to adjust the saturation. This feature only
works under Custom in Picture Mode.
tc:(:::\orerature Press n / u on the remote control or click a preset color temperature for
P the image. Options are Cool, Warm, Standard.

Note: Hue, Sharpness, and Image Noise Reduction cannot work on Android input.
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Local Delivery

Playing content with Local Delivery

With X-Sign Local Delivery, you only have to connect your PC (Designer) with BenQ Smart Signage
in the same subnet. Then you can play and schedule the content with the device(s) without other

servers or Internet.

Note: The maximum number of devices that can be played by Local Delivery is |6.

I. Switch to Local Delivery and Interactive feature, then press Close. Refer to Creating a new
project file in X-Sign Designer on page 53 for more information.

Switch Mode

Unpaired
This pairing code can Not enable interactive feature.
The source of content is from Designer.

Standalone(USB)

Device Name: Unassigned
Hardware Code: d0:c5:d3:26:36:6a

Local Delivery kit
And Interactive feature
(Pairing...)

O Manager

Close

2. Make sure your PC and devices are in the same subnet. Open X-Sign Designer on your PC.

3. You can press Delivery on the main page or on the top function bar. You can choose Local
Delivery to deliver files.

Edit Insert  Arrange View Preview Video Wall Help

Loca Devery
New Page (1)

Standalone(USB)

Basic Tools

Local Delivery

I. On the Devices page, you will see all devices which are in the same subnet and in Local Deliv-
ery and Interactive function mode.
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z Change the name for the device.
-: Stop current playing content of the device.

E: Device screen has the flash effect to let you distinguish which device is being used now.

Devices

[_] DEVICES .

Name =« P MAC Address Channel Status

BenQ CS8601 192.168.1.54 d4:9e:3b:5e:63:3f Winnie [ ]

CHANNELS

2. Before setting schedule and playing content, you must add the device into the channel.
3. Go to CHANNELS, then press Add Channel.

Channels

[] Devices
Add Channel

Name = Number of devices Description

sem Channels

4. For creating the channel:

A. Enter the basic information of the channel.

B. The device list is already in the channel.

106 BenQ X-Sign



C. Add a new device into this channel.

Channels > Add

[] Devices
Name
~\ Description
C Add Device

Channels

ETT]
Name = P MAC Address Status
Confirm Cancel

5. Select the device you want to add to the channel, then press Confirm.

Channels > Add > Add Device
DEVICES
Name « P MAC Address Channel Status
IL4 18:65:71:38:36:4¢ T
% CHANNELS BenQ IL490 7C13F7EC-E710-467F-84A9-...
+| BenQ ST550K 192.168.0.114 40:8b:f6:44:b4:22 [ )

+| BenQ ST750K b0:c5:cc:70:02:9f
dcc2jackyhsieh 0a:00:27:00:00:15
Confirm Cancel

Note: A device which is already added to one channel can't be added to another channel. You have to
remove it from its channel first.
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6. You can also press [ to remove devices from the channel.

Channels > Edit
] DEVICES
Name test
Description
Add Device [1)
o2 CHANNELS
Name = P MAC Address Status
BenQ STS50K 192.168.0.114 40:8b:16:44:b4:22 @
BenQ ST650K b0:c5:ca:70:.02:a4
Confirm Cancel

7. After the channel is created successfully, you can control channels as below.

D : Set Schedule for the channel.
/f : Edit the channel for the basic information and the devices in it.
-: Stop the current playing content of the channel.

[l : Delete the channel.

Channels

DEVICES
— Add Channel M 2

=]

Name = Number of devices Description

‘ BenQ 1 123

5. CHANNELS
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8. Press D and you can set schedule for the channel. Press Add Schedule to create a new
schedule for the channel. You can also double click the time table to create it based on the time

you choose.

] Devices

2. Channels

Channels > Schedule

Add Schedule

00am

0lam

02am

03am

04am

05am

06am

07am

9. After pressing Add Schedule, you can start to set the schedule.

A. Choose the project you want to play in the schedule. Press ¥ and you can see the recent
file. Press Browse to select the file from the file explorer.

B. Choose the project you want to play in the schedule and select the start and end time. Press

Save to continue.

Edit Schedule

Schedule name

Deliver File Test_0821_sealing fea--- Browse

Time | All Day

Start 01:00

End 02:00)

Remove
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10. Select Local delivery to play the file.

Channels > Schedule

Add Schedule

00am

Q Devices

01am

ssa Channels

02am

03am

05am

06am

p7am _

Searching for devices in Local Delivery Mode

Local Delivery allows different displays to be connected over the same local network. This is an
introduction to viewing devices in Local Delivery Mode.

To open Local Delivery Mode:

I. Launch X-Sign Designer and select Local delivery.

File Edit Insert Arrange View Preview Delivery Video Wall Help

0

s | =

Open Project New project New Interactive Project Local delivery

O

Demo Video

Note: If X-Sign Designer is already open, you can select Delivery > Local Delivery from the top
menu.
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2. The Device window will appear showing all the local devices currently connected to the

network.

Devices

[] Devices

Name = P MAC Address Channel

2. channels
Ty

Can't find any device in the same subnet.

Status

3. Select the device you want to edit from the list and then select any of the following items.

Devices B C
Name = IP MAC Address Channel Status
BenQ CS8601 192.168.1.54 d4:9e:3b:5e:63:3f Winnie o

A. ,: — Click this button to bring up the device name window. Click the text and enter the new

name for your device.

B. .— Click this button to stop the content on the current device.

C. [Z] — Click this button so that the device will flash a black screen. This function will help you

identify a specific display when multiple devices are connected to the local network.

Setting a schedule for Local Delivery Mode

When operating several devices in Local Delivery Mode, you can set different schedules for each

display to broadcast content. Devices are first added to a channel and then a schedule is set for that

channel. Below is an introduction to setting a schedule in Local Delivery Mode.

To create a channel in Local Delivery mode:
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I. Launch X-Sign Designer and select Local delivery.

File Edit Insert Arrange View Preview Delivery Video Wall Help

)

4 |

Open Project New project New Interactive Project Local delivery

O

Demo Video

2. In the Device Window click CHANNELS, then click Add Channel to create a new schedule.

Channels

(] Devices
Add Channel

Name = Number of devices Description

Channels
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3. In the Add Channel window you can select the following:

Channels = Add

A |Name . Afternoon Sale |
B |Descripti0n . Weekday Sales Info |
c D[s
Name = IP MAC Address Status
BenQ STS50K 192.168.0.114 40:8b:f6:44:b4:22 [ ]
BenQ ST650K b0:c5:ca:70:02:a4
Confirm Cancel

A. Name — Enter a name for the channel to be broadcast.
B. Description — Enter a description for the channel to be broadcast.

C. Add Device — Click Add Device to add displays to this channel. In the pop-up window
select the checkbox next to the device(s) you want to add and click Confirm.

D. 'uLj — Select the device you wish to delete from the channel and click this icon.
4. Click Confirm to create the channel and click OK.

To set a schedule for a channel in Local Delivery mode:

[. In the CHANNELS window, select the channel you want and click the D button to add a

schedule.
Channels
n|en e
Name « Number of devices Description
BenQ 1 123
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2. Click Add Schedule to create a new schedule for the channel. You can create and edit time
blocks in the timetable by clicking and dragging.

Channels > Schedule

Add Schedule

00am

0lam
02am
03am
04 am
05am
06am

07am

3. Choose the project you want to play in the schedule and select the start and end time. Press
Save to continue.

Edit Schedule

Schedule name 123

Deliver File Test_0821_sealing fea-- Browse

Time [ All Day

Start 01:00

End 02:00|

Remove
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4. Click Local delivery to deliver the schedule to the assigned devices in the channel.

Channels > Schedule

Add Schedule

00am

0lam
02am
03am
05am
06 am

07am
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Report

Getting the activity report of X-Sign Manager

I. To access the activity report of X-Sign Manager, go to Report Analysis > X-Sign Manager
Report.

2. Choose start time and end time, then click Export.

Available space : 99.5 GB 22 AccountManagement 8 BenQ @ Language @ °

cMs Broadcast ‘ X-Sign Player Report

Select Report

player Content Report -
By Device
By Channel Select Device 123456 3
*  File Management Start Time £ | 2019-12-17
> Verification End Time | 2019-1224
» My Favorite
»  Report Analysis

Touch Usage Report (Beta)
X-Sign Player Report

X-Sign Manager Report

Advanced Application

License Management

About

3. The activity report is exported as an .xls or an .xIsx file type.

al x fr || Time Stamp(GMT +00:00)

A B C D E
1 [Time Stamp(GMT +00:00) _ |Event Account(Authority) 'Action  Detail
2 |2018-03-15 05:59:45 Device Activity AlbertKang{Administrator) Remove Device(W_PC)(SFRQ625Q)
3 |2018-03-15 05:59:59 Device Activity AlbertKang{Administrator) Remove Device(WPC)(BNJ8GYCR)
4 |2018-03-15 06:02:04 Device Activity Albertkang{Administrator) Add Device(demoroomwriter)(8MVRSPHZ) with City{Taiwan) Channel{Uncategorized)
5 2018-03-15 06:34:46 File Activity AlbertKang|{Administrator) Upload File Name(test03333333)
6 2018-03-15 13:02:21 Device Activity AlbertKang{Administrator) Remove Device(11f)(DHFFGB7P)
7|
8 |
9 |
10|
11
12 |
13|
14 |
15|
16 |
17|
18 |
19 |
20 |
21|

XSignManagerLog2018-03-19 | @ A1

Downloading player content report

I. To access the player content report, click Report Analysis > X-Sign Player Report > player
Content Report.
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2. Choose start time and end time, then click Export.

Available space

\ccount Management

BenQ @ Language

B oo | X-Sign Player Report

3. The

By Device

By Channel

File Management

Verification

My Favorite

Report Analysis

Touch Usage Report (Beta)

X-Sign Player Report

X-Sign Manager Report

Advanced Application

License Management

About

Select Report

Select Device

Start Time

End Time

player Content Report -

123456

M 2010-12-17

£ | 2019-12-24

report is exported as an .xls or an .xIsx file type.

FL6 - Je
A B c D E | F | G H 3 K M N

1 |Playstatus  Playtype  Playname Play startat schedule name  Device name  Logged at Logged at UTC
2 start play interrupt PIT land 2018-12-21 13:55:34 test AKNB_Dnt_MV 2018-12-2113:55:34
3 endplay interrupt PIT_land 2018-12-2113:55:34 test AKNB_Dnt_MV 2018-12-21 13:58:05
4 start play interrupt 1234 2018-12-21 13! test AKNB_Dnt_MV 2018-12-2113:58:05
5 lend play interrupt test AKNB_Dnt_MV 2018-12-2113:58:12
6 start play interrupt 1234 2018-12-21 15:18:! test AKNB_Dnt_MV 2018-12-21 15:18:55
7 playing interrupt 1234 2018-12-21 15:18:55 test AKNB_Dnt_MV 2018-12-21 15:28:55
8 playing interrupt 1234 2018-12-21 15:18:55 test AKNB_Dnt_MV 2018-12-2115:38:55
9 playing interrupt 1234 2018-12-21 15:18:55 test AKNB_Dnt_MV 2018-12-2115:48:55
10
1n
12
13
14
15
16| 1
17
18
19
20
21
22
23
24
25
26
27
28
29
30
a2

PlayLog

®

[«
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Video Wall

Setting up the environment for video wall

With X-Sign Manager and Player, you can easily set up the video wall environment with BenQ Smart
Signage. You can see the following |1x3 video wall for example.

I. Pair all devices which are used for video wall with X-Sign Manager.

Device Management - DemoRoom_430K e
‘Add a new display add category Device Updates Search
+ [ Device Management
Status ¥ Name Channel name Display ID
<
{ ] R 430L DemoRoom_430_videowall FDEPXNJX
L ] 430M DemoRoom_430_videowall UBIGHWLL
e 430R DemoRoom_430_videowall VRRAXRHS

2. Go to Channel Management to create a channel to add these devices to the channel.

Channel Management

Channel edit

Channel name

Play without schedule cture
X-signBackground.png

Anti retention Disable

Description None

m Delete channel

Set Equipments

Add unsubscribed equipments to this channel

|_] Device name =~ Display ID Device version Category Expired date
[ 430 FDEPXNJX DemoRoom_430K
] 4s0m UGIGHWLL

30R VRRAXRHSG 2083
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3. After the channel is created, select the channel and choose i .

32 Account Management B Heud Quarer @ Language 41

I Type Channet Name Equipal

* License Management

Apout

Norma

4. Below is a brief introduction for creating the Video Wall.

A. Extend the content to all devices or set each device to play the same content mode.
B. Set the resolution for each device. You can also customize the resolution yourself.
C. Decide the Panel Area, H (Horizontal) x V (Vertical).

D. Assign each display's position in the Video Wall.

E. Enable the bezel correction function for BenQ Smart Signage's display margin.

Available space - 99.5 GB 22 Account Management
B - | Video Wall Seting oro
By Device Name within 50 characters

By Channel

Mod i i i
i oo A ode @ Expanded Display Be|nq Duplicated Display [I=TS 110} BenQ

* Verification

B Screen Resolution(One Screen) No Setiing V.
* My Favorite

Report Analysis ‘ Area 1 -2

» Advanced Application D 5 5
evice Position

License Management

No Setting Valuw  No Setting Valre

About *Hint: if you are not a BenQ smart signage, you'll have to manually input the corresponding specification of your device.

Synchronization waiting 1000 (input: 100~3000)
period(ms)

E Bezel Correction ® Disabled
Enabiedo

Content Calibration  No Setting Value

Cancel

5. After all configuration is set, click Confirm.
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6. Set one Android box for installing VideoWallController apk. Then put the Android box and all
devices in the same subnet.

7. Select VideoWall Devices Info, and you will see all devices for Video Wall on the list.

BT - | Crame

I By Channel

Search. Q

Type ¥ Channel Name

» File Management -

> Verification
Normal o718 2

My Favorite

Normal 12345_Channel |
» Report Analysis

Normal 20190707test "
» Advanced Application

Normal abed 5
> License Management ol

About Normal BenQ o
Normal Howard_0826 o

Normal teste 2

Creating the Video Wall content from X-Sign Designer

With X-Sign Designer, you can easily create content for the Video Wall display.
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I. Create a new project.

File Edit Insert Arrange

Open Project

2. Below is a brief introd

View

Preview Delivery Video Wall Help

4 |

New project New Interactive Project Local delivery

O

Demo Video

uction for Video Wall setting.

A. You can set the device in landscape or portrait mode.

B. You can choose the resolution of each device.

C. This shows the Panel Area (Horizontal x Vertical).

D. This shows the sim

ulation of the Video Wall and the overall resolution.

- C:\Users\user\Documents

Project name Video Wall
Singie disnhay @ Byresoluton () By device
resolution: Y b
A Landscape -
B 1920x1080 -
Panel Area C 2 v x |4 -

For Android Video Wall, only supports up to 4 devices.

Video Wall resolution: 7680x2160

Note: Android Video Wall only supports up to 4 devices.

3. After all configuration

is set, press Confirm.
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4. Now you can start to design your content.

) X-Sign Designer - C:\L xml - X
gt g

View  Preview  Delivery  VideoWall  Help

T
g O
o\

Page

Name New Page (1)

Duration 00:10:00
Resolution  7680x2160 Modify
PanelArea  2x4

Transition

Effect None

Background
Color #FFFFFF

2 With background image
Background Audio

W With Background Audio

Fine-tuning the Video Wall from X-Sign Designer

X-Sign Designer offers vertical and horizontal micro-adjustment for the Video Wall display. The
feature is designed to perform fine-tune when there is minor difference introduced during installation.
If there is a significant gap between screens, please adjust the physical installation instead.

I. To access theﬁfjne-tune adjustment, select Video Wall.

Video Wall

Welcome to X-Sign Designer

Please enter your BenQ account first or Start your project now!

yes
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2. Click FINE TUNE to check the channel list. Then click the Video Wall display to have minor

adjustment.
Channels
= FINETUNE
Name 4 Mode Area Compensate Online
‘ 2byl Extend 1x2 Enable 2/2

3. With FINE TUNE, the selected Video Wall display(s) can be micro-adjusted along the X and Y
axis. Click Save to complete the adjustment. The unit of measurement is millimeter.

X Close

Channels > Fine Tune

=, FINETUNE

5501_Left 5501_Middle
QPBBPFBM 4JWP4H64

offsetX : i) H offsetX : i) H
offsetY : ] H offsetY : ] H

Note: For the fine-tune adjustment, the maximum number of Video Wall devices supported is four.
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Premium

Interactive

Creating interactive content with Interactive template

X-Sign Designer Interactive template can help you create interactive content in a few steps. It will be
the best solution for BenQ smart signage IL series (with touch function).

I. Launch X-Sign Designer, then choose New Interactive Project.

File Edit Insert Arrange View Preview Delivery Video Wall Help

— 'é\,
HEE ~ah
ol
=0 HENR
O . -
Open Project New project New Interactive Project Local delivery

C

Demo Video

2. Choose the template style you want to use. Set the name and path for the file, then press
Confirm.

_- D:\Users\Bobby.Y.Chen\Documents

File name ltest]

| [ Coiimon Jam
| A&
% QR -

F nEs % 0
B .
ﬁ | AN =l

Confirm
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3. Press Map View, and you can see the structure of the template.

) X-Sign Designer - C:\Users\user\Documents\UM\scene.xml - X

Edit Inset Amange View Preview  Delivery  VideoWall  Help

9E Map View [ Preview

Denim
Collection
i) O Upto 5 Hff
O
Property -
WOMEN 4 Te Levet
\ et
ouaton 000010
.
.
T
MEN i #FBF8F8
packgroundimage
S
I
KIDS

1080x1920  X:2844  Y:1958 7 T

4. Below are the basic functions of Map View.

A. Choose the page and you can see the preview on the left side.

B. Choose Edit to go to Layout page (Level X) to change the layout.

C. Choose the page and you can see related subpages. Hold down the page then drag and drop

to change the page order. Double click to go to the content page (LX) directly to edit.
* There are three layers’ structures:

Level |: Main page

Level 2: Category

Level 3: Item/ Product

Promotion Page Level 1 B
A WOMEN = (E{ 5
P,
&
]
L1
Level 2 Edit
2am 1am Jam
ALY ALY AL
i ﬂ&. A #5&. i ‘3&.
mas mas mas
L2-1 L2-2 L2-3
Level 3 Edit C
Ne= . Nw= . Ne= 1 Nie= i
& 1 & 0 & 0 & 1
L3-1-1 L3-1-2 L3-1-3 L3-14
N Nwx Ne= LT
L] L} a 1
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5. On Layout page (Level X), click Category Generator to change the layout.

%) X-Sign Designer - DAL 'Chen\D enexml * - o ®
File Edit Insert Arrange View Prewiew Help Local Delivery

K Edit mode = Map View [] Preview Save v @ bobbychen ~

/ test Levell - e = -
Basic Tools A y Layer -

5 ® T build-in (Text)
Denim

Collection @ T build-in (Text)

Up to 50% off ® build-in (Category Generator)

@ @ buildin (Image)

T ]

Text Image

o O

Video Rectangle

O WOMEN
Oval £ e 3
\| I Property v
| Category Generator .

Name

X 0 ¥ 608
MEN
Saciin Opacity _—

Layout -
Layout T

Spacing

KIDS

1080 x 1920 X:2452 Y:1806 W:1080 H:1312 -+ 3% + =

6. On Content page (LX), double click Import images to import the content to Category
Generator.

X_Clo;
I Import images I TouchReport | Select All
Order Image Title Subtitle Touch report Edit visible ar2aDelete

WOMEN

1~ g WOMEN See more v Description 1 £ |

|

2 ‘ MEN See more v Description 2 s 2
MEN

3 @ KIDS See more v Description 3 £ L]
KIDS

7. Below are other functions of Category Generator.

A. Change the order of the items. Drag and drop the item to change the order.
B. Change the image source.
C. Change the display strings here.

D. Enable Touch Report to see the touch analysis report on Manager. You can enable/disable all
by pressing the top-right button.
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E. Set the visible area for the picture of items.

Drag image to mofy the visible area

Save Cancel

F. You can also right click mouse to delete it. Once you delete the item, you also delete related
subpage(s) which can’t be recovered.

G. You can preview the page. You can scroll to see the whole page.

Import images I Touch Report Select All I D)
Order Image Title Subtitle Touch report t visible 3 Delete
WOMEN
1 p. WOMEN See more v Description 1 £ a
Y .
2 & MEN See more | Description 2 £ a
MEN
3 g KIDS See more v Description 3 £ L]
J J
A B c D E F
KIDS r ) ) )
G
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8. The number of items you import into the template will automatically generate the related next

layer.
T

LI L LAt
L J % Closs

Import images Touch Report  Select Al

Title Subtitie Touch report Edit visible arsa Deleto

Image
£
1 = -y ! Title 1 Subtitle 1 o Description 1 £ [ ]

Title 3 Subtitle 3 =4 Description 3 £ e

h ]
2 m Ttle 2 Subtitie 2 v Description 2 £ 8

4 'rﬂ ‘ Title 4 Subutie 4 L Description 4 £ [

Ad page Level 1 Edit
M —
. wl
Denim e
Collection = ||
Up to 50% off Main Page
Level 2 Edit
Titke 1 Tithe 2 Titke 3 Title 4

Level 3 Edit
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9. On Layout page (Level X), you can insert a widget. It will apply to all related Content pages (LX).
You can't insert any widgets in Content page (LX) separately.

X

Local Delivery

- %[ i
ill apply to all sub pages with the same level

i

® = object 5(image)

® = buildin (image)

- Rectangle
™ Rectangle

® (3] buildin (Category Generator)

Rectangle

® T buildin (Template Text)

Resolution  1080x1920

Panel Area =
Background
Color sFeFeFa
-— 4 i Image
. i Add Delete
i magestie  Fill -
: Background Audio -

100011920 X:2600 Y972 -+ 4 -

4 w121 - L3 e [

Basic Tools SattingdadbisDageyyll apply to all sub pages with the same level Layer -

. B - EEr——

® @ buikkin image)

® [ Rectangle

. ® O Rectangle
[ -] [

[ buikdin (Category Generator)
Rectangle

T buildin (Template Text)

0

wa_Echpse_1280x72009

1080 % 1920 XU Y32 Wi Hoie -+ M8 - 3

[0. On Layout page (Level X), you can also remove a built-in widget in the interactive template.
Once the widget is removed, it can’t be recovered.
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I'l. On Content page (LX), you can set the content for a built-in widget.

X/ X-Sign Designer - DA\Users\Bobby.Y.Chen\Dx | - o x
File Edn dmert Artenge View  Prewiew  Help  Local Delivery

~trvel

Setting in this =~ = o e .
/ - L A v ® =
Banc Tools “ Layer
Title 1
™ Rectangle
.g_ = - Rectangle
® @ buidin (Image)
— ® = buildin (Template image)
[+ ]
® i bulidin (Template Image)
- Rectangle
@ T buldin (Template Text)
Property
Template image
52 228
542 3 724 C
0
————

. image C2175162jpg

- Content

1080 %1920 X632 YINI0L Wise MM -+ 4 -

12. Enjoy creating your interactive project with our interactive content.

Creating interactive content from designed templates with Area Link

There are two ways to create interactive content in X-Sign Designer.

* Interactive Template: Three layers’ structures designed by BenQ Designer which make you change
your content easily. Refer to Creating interactive content with Interactive template on page 124 for
more information.

* Area Link: For you to customize the link relation yourself. You can easily use it to turn the original
project into the interactive project as you wish.

The following is an introduction of how to create an interactive content with Area Link.

Note: Be sure that your smart signage has successfully imported with the interactive content
otherwise the touch function may not work.
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I. Open the project you want to change to the interactive content, then select Overview mode.

DAUsers\Bobby.Y.Chen\Desktopiinternal release1225\arealink1226\scenexml|

Prewiew Help Local Delivery

arealink1226
144

Music L 3

03

-
Boutique-Watch-2 1080x1920 Boutique-Watch-1 1080x1920 Boutique-Watch-3 1080x1920
Repest 1 time(s) = |  Totalplaying time 0:40 Repeat 1 time(s) = | Total playing time 0:40 Repeat 1 time(s) = | Total playing time 0:24

2. Choose the page you want to set the link, then press Set Link Area.
X/ X-Sign Designer - D:\Users\Bobby.Y.Chen\Desktop\internal release1225\arealink1226\scenexml

! Prewiew Help Local Delivery

arealink1226

144 Music

Set Link Area

Boutique-Watch-2 1080x1920 Boutique-Watch-1 10801920
Repeat 1 time (s) - | Total playing time 0:40 Repeat 1 time (s) - Total playing time 0:40

i

3. You will see Link Area setting wizard. Drag an area to create an Area Link.

sp\internal release1225\arealink1226\scene.xml

w Help Local Delivery

EditLink Area | Boutique-Watch-2 1080x1920

= Walches

4. In Area Link configuration, you can set:

A. Set the page you want to link to. After tabbing the area, you can see the related page.
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B. Set the link effect. You can go to the link page directly or to the link page overlapping the
original one.

C. Set the transition effect.
D. After you finish the setting, you can preview the effect.

E. Go to and edit other pages.

Prewiew Help  Local Delivery

Edit Link Area | Boutique-Watch-2 10801920 D) ('- )] [€ )]

a\ Set Link To
r=i

Choose a destination page -

P
BJ Go to page -

Tt

ar

B :
Transitions.

Gy

) Cube

5. Set link to the previous page, then you can go back to the previous page.

Link Area | Boutique-watch-1 10§0% v prevew) (% =)

Set Link To

Previous page -

Go to page =

Gesture

B

Transitions

Cover From Right =

6. After you finish the setting, press Save.

7. Now you can enjoy creating interactive content.
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Viewing the structure of an Interactive Template

You can use Interactive Templates in X-Sign Designer to create interactive projects for your
touchscreen display. The following is an introduction to working with Interactive Templates.

Note: This feature is for BenQ members who have purchased a Premium License only.

To open an Interactive Template in X-Sign Designer:

I. Launch the software and click New Interactive Project.

File Edit Insert Arrange View Preview Delivery Video Wall Help

— 'é\,
HEE ~ah
¢ 1
v =o HEN
(| 5 —
Open Project New project New Interactive Project Local delivery

O

Demo Video

2. Choose a location on your hard drive to save the project and create a File name. Select the e-
brochure template you want to use and click Confirm.

m
| File name | Storefront
.l.a-brochure(ponra'rt)

‘&‘ frati '_' “l S[

oy A&

= Ay =
e-brochure (landscape)
F PRI S

Confirm
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3. You can preview the layout of the Interactive project by clicking on Map View.

File Edit Insert Arrange View Prewiew Help Local Delivery
B

Edit mode m Preview

Basic Tools

Denim

Collection
Up to 50% off

T >

WOMEN

Property
Page
Name
MEN
= Duration

Resolution

Save ~

Levell

0.000

1080x1920

Panel Area 1x1

Background -

KIDS

Color ‘ #FBFBF8 ‘

4. Each interactive project consists of 3 Levels, and each level consists of a Template Page and
Content Pages:

Promotion Page Level 1 Edit
WOMEN & =
P
"
- 5
L1
Level 2 Edit
Jam Jam 2am
YA AL AL
Nk Rl J e
ma.s mas ma.
L2-1 L2-2 L2-3
s [ B

Mg = M= Mg s Nip=
[} L] L]
& 1 & 9 & 9 & 9
1311 1312 1313 1314
Niw= Niw= e | Niw=
] L} ] "

A. To preview a specific Content Page, click on its icon on the right side. To edit the selected
Content Page, double-click the icon.

B. To edit a Template Page (which will affect the layout of your Content Pages), click the
Edit button next to the Level you want to adjust.
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5. You can also navigate to each Template Page and Content Page by clicking the « button

at the top of the canvas and selecting the page from the drop-down list.
-

Storefront Id

<&

=129

-L2-3

-L311
1312

1313

F 1314
q 1315
1317

-L318

1319

-L3-1-10

| e E

To customize a Content Page in Level 3:

I. You can change each image displayed in a Content Page by selecting it in the canvas, then going
to the Template Image panel on the right and click the ... button.

Storefront L3-1-1 -

White Lace Tank top

DOLOR: White
SIZESMLNL

PRODUCT DETAILS

MORE INFORMATION
[=]g:[m]
B [T ——

YOU MIGHT ALSO LIKE H

& 9

A
Layer
Property

Template Image

336

260

982

260

level3_image3.png

None

ast
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2. Choose the image you want to use from your hard drive and click Open.

s B
X Select image file: M
@U'| . <« Dessert » Dessert-11920:1080 » assets - ‘ $,| Search 0 |

Organize ~ Mew folder =~ 0 @
%l Recent Places = " - ST FESTIVAL B .
1775444677.png  1088768596.png  2102188116png  2161050545.png
- Libraries -—
@ Documents
J7 Music L
= STRAWBERRY
H videos 2323359561.png 2438896119.png 3185256865.png
1% Computer EJ E """ =
£, Local Disk (C3) p '
—a Data (I) E S ﬁ 1
¥ BackupData (\WE
3 Common (\ETA 3323586278png  3538803lpng  35723133%png  3083911%L.png
5 michaelvokins.tt ] i
File name:  2678948725.png « |Image files (*jpg *.png *.gif *.b ~
y

3. You can change the text displayed in a Content Page by double-clicking it in the canvas, and
then typing in your own text.

Starefront L3-1-1 - | s [l-ﬂ *
Layer »
Property -
White | ace Tank 100
Template Text -
5
Name
SIZESMLXL ! o
' X 644 - v 355
PROOUCT DETAILS Width 462 : 'E-'-‘_|" 22 :
o
I .
MORE INFORMATION
Content -
(=] =]
LASGE wovterncom ont Sans Serif Condensed  ~

4. You can edit the URL for a QR code in a Content Page by selecting it in the canvas, then
going to the Content panel on the right and clicking Edit Address. Enter the QR code link
and click Confirm.

Starefront L3-1-1 = R =
I Layer ’
Property -
White Lace Tank top
_ Template QR Code ¥
COLOR: White o
SZESMLYL - -
644 1070 2
PRODUCT DETAILS 149 : Height 149
[
ns ]
MORE INFORMATION
Content b
[m] = [m]
P v e com Edit Address
u o r
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To customize a Template Page in Level 3:

I. You can customize the layout of a Template Page for Level 3 by selecting any of the following
items in the canvas:

Starefront Level3 -

Classic White T-shirt

E |
Iw

COLOR: White
SIZESMLXL

MDH@URM,&TIDN
k0]

SR [ =T [—
F

[=

A. Template Image — Select the image in the canvas and then customize the settings in the
Template Image panel and the Content panel.

B. Template Text — Select the text in the canvas and then customize its settings in the
Template Text panel and the Control panel.

C. Template QR Code — Select the QR code in the canvas and then customize its settings in
the Template QR Code panel and the Control panel.

2. If you want to delete any Template images or text from the Template page, select the item in
the canvas and press delete. A warning message will appear, click Yes to delete or No to exit.

This component can not be added after the deletion, do you want to
continue?

Yes No
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3. You can add new images, text or widgets to the Template Page by using either the Basic tool

or Widget panel. Click / to access the Basic tool panel or click W to access the Widget

panel. Refer to Creating content in X-Sign Designer on page 58 for more information about
using these tools.

Edit Insert Arrange View Prewiew Help Local Delivery
Edit mode = Map View [*] Preview Save
- Storefront Level3 - o)l fl vig = -
Basic Tools 1 - Layer »
| g
o = = Property -
T m Classic White T-shirt Text -
Text Image .
Name object 26
COLOR: White - -
n D SIZESMLAL X 198 = Y 167 .
Video Rectangle Width 220 : Height 61 :
Rotate 0 :
Gl Transpa.. &

For Level | and Level 2 Template Pages and Content Pages, you can add or delete pages, and

customize images and text in the Category Generator window. To access the Category
Generator window:

I. Navigate to the desired Content Page in Level | or Level 2, and then double-click the Cate-
gory window in the canvas.

- ol R[] = -
Layer -
Denim
Collection
Up to 50% off : = :
WOMEN r
Property b
Category Generator -
Name Sections
X 0 | v 458
MEN Transpa &
Layout -
Layou i1 4 | -
Spacing
40 =
KIDS
SEEmare Imagestyle .
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2. You can edit the following items in the Category Generator window:

Import images Touch Report Check All
I Order | | Image | | Title | ISubimel ITuuch Repurtl IEdrtwsibIeareaIDeletel

WOMEN

1 9 WOMEN See more v Product_1 £

E

2 é MEN See more v Product_2 £
MEN

3 "'P] KIDS See more v Product_3 £
KIDS

A. Order — Click and hold, then drag a category row upwards or downwards to change the
order of the items.

B. Image — Click the image icon and choose a new image from your hard drive. Click Open
when finished.

C. Title — To change the Title text, select the text in the category row and type in your new
text.

D. Subtitle — To change the Subtitle text, select the text in the category row and type in your
new text.

E. Touch Report — Touch Report allows you to track the touchscreen data of specific pages or
categories. Check the box to generate Touch Report data for the category.

F. Edit Visible Area — Click # to change the positioning of the category image.

G. Delete — Click to delete the category and all its sub-pages.
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3. You can add new Category pages by clicking Import images.

Import images | Touch Report Check All
Order Image Title Subtitle Touch Report Edit visible area Delete

WOMEN

1 P WOMEN See more »' Product_1 £

:

2 é MEN See more v Product_2 £
MEN

3 "‘-g KIDS See more v Product_3 £
KIDS

4. Select the image from your hard drive and click Open.

X| Select image file: @
@\:j" . < Dessert » Dessert-11920:1080 » assets - |&7 ‘ | Search assets L2 [
Organize » Mew folder = + [0 l@l

ol Recent Places = P FESTIVAL -
1775444677 .png 1988768696.png 2102188116.png 2161050546.png
- Libraries —
3 Documents
rJ“w Music L
Pict 1 -
N STRAWBERRY =
H videos 2323350561.png  2438806119.png | 2678948725.png  3185256865.png
y 27 T
18 Computer E-’ E { .- =
£, Local Disk (C) p L &)
= Data (D) =158 ‘ oy I
¥ BackupData (\WE .
&% Common (\ETA 3323586278.png 3538803341.png 3572313399.png 3988911961.png
S michael.vokins.tt T | 2
File name: 2678048725.png - IImageflIes (".jpg *.png ".gif *.b ']
| [ Open l | [ Cancel ]

5. You can change the Touch Report settings for all categories by clicking * . Refer to Enabling
Interactive Statistics on page 140 for more information.

Enabling Interactive Statistics

For X-Sign Designer, interactive projects can record the touch statistics of each page within an
interactive project. The following is an introduction to enabling and reviewing interactive statistics.

Note: This feature is for BenQ members who have purchased a Premium License only.

To enable the interactive statistics for an interactive project:
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Navigate to the desired Content Page in Level | or Level 2, then double-click the Category
window on the canvas.

Insert Arrange View Prewiew Help Local Delivery

Edit mode . = Map View ] Preview
’ . % = [ 3 = -
Basic Tools Layer -
Denim @ T built-in (Text)
T [Cad COHECﬁOH ® T built-in (Text)
© @ built-in (Image)
i O
Video Rectangle
WOMEN
Oval
Property -
Category Generator .
Name Sections
MEN X 0 =t Y 458 _
Sec mDE
Transpa.. =
Layout -
Layout 1x1 87
KIDS Spacing [ .
i 40 -

Under the Touch Report column in the Category Generator window, select the checkbox
next to each item you wish to track touch data.

Import images Touch Report Check All
Order Image Title Subtitle Edit visible area Delete
WOMEN
S i I g WOMEN See more v Product_1 £ [
A

2 ‘ MEN See more v Product_2 £ 8
w

3 g KIDS See more v Product_3 £ 8

KIDS
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3. You can also change the Touch Report settings for all categories by clicking in the Touch

Report drop-down menu. Select Check All to generate Touch Report data for all categories
or select Uncheck All to not generate Touch Report data for any categories.

Import images Touch Report Check Al
Order Image Title Uncheck All 1Report Edit visible area Delete

WOMEN

1 i& WOMEN See more v Product_1 £ s

i

2 é MEN See more v Product_2 £ fu
MEN

3 ""'; KIDS See more v Product_3 £ fu
KIDS

Note: To review the interactive statistics, refer to Viewing an Interactive Report on page 142 for
more information.

Viewing an Interactive Report

Once you have enabled interactive statistics for an interactive project, you can view the data for your
statistics in X-Sign Manager. The following is an introduction to viewing and reviewing interactive
reports.

To review the interactive statistics for an interactive project:

I. Log in to your X-Sign Manager account. Go to Report Analysis > Touch Usage Report
(Beta).

2. In the Touch Usage Report (Beta) page you can review statistics using the following items.

A B~ C D E | F G H

4
m

xport Data ¥

Display item : Product - All

L N
B Click times Average - 6.9
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A. Type of Report — Click = to choose one of the following data sets to display: Click,
Product, Channel, Category, or Device.

B. Export Data — Click = to choose an export setting from the dropdown list. You can select

All Data (CSV) to export all interactive data to a csv-file format, or you can select Data in
this page (PDF) to export the data displayed on the page to a PDF.

C. Date From — Choose the start date for the data you want to display in your report.
D. To — Choose the end date for the data you want to display in your report.
E. OK - Select OK to confirm the selections and generate the report in the window below.

F. Product - Select Product to choose the data for specific products (i.e. - categories) you
would like to display in your report.

G. Channel - Select Channel to choose the data for specific channel(s) you would like to
display in your report.

H. Device - Select Device to choose the data for specific device(s) you would like to display in
your report.

Setting the device group control

To control the device group, go to X-Sign Manager and click By Device.

Available space - 98.8 GB =2 Account Management 2 BenQ @ language @
B - | Aldevices o
<
Add a New Device Add Category X-Sign Player Update Search
By Device + B Al devices (10)
By Channel
All devices
* File Management
Stat ~ Name Channel Name Device ID pack
* My Favorite us
* Report Analysis
)‘ X-Sign  AlbertPC PMSG CC Video ... G3XNZLKA
* Advanced Application
»  License Management e =

= AKNB Albert's Channel ZRK2ZT4Z

Premium
2019-12-07 08:2

~ " Premium
u AKNB-ASUS Unsubscribed 272JFH3A 2019-12-08 09:0

2 PMSGCC Demo

AK_Surface Unsubscribed KUD7RL53

About
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2. You can select the device(s) you want to control, then click Screen Settings ﬁ

Available space : 93.8 GB 2 AccountManagement 8 BenQ @ language @

«

) Add a New Device ( Add Category X-Sign Player Update Search
By Device ~ Bs All devices (10)
By Channel » I8 PMSGCC Demo (2)
File Management

$ )

Stat ~ Name Channel Name Device ID pack
* My Favorite us
* Report Analysis
x X-Sign  AlbertPC PMSG CC Video G3XNZLKA
* Advanced Application
*  License Management pmel M
L] ' y AKNB Albert's Channel ZRK2ZT4Z
. Premium
l;'f‘_r -~I AK_Surface Unsubscribed KUD7RL53 2019-12.07 08:2
Premium
AKNB-ASUS Unsubscribed 272JFH3A
u i 2019-12.08 09:0...
2 B PMSGCC Demo

About

3. You can select the playing time and the content will be played everyday between the start and
end time repeatedly.

Screen Settings (All devices)

A This setting will be applied to the 10 device under the group. Are you sure to apply it?

Automatic switch mode

.On

EveryDay © | 09 00 o 20 00

u Itwill ically restart 5 mi before the screen is turned on.

o @

4. You can set the automatic switch mode to On or Off, then click apply.

Screen Settings (All devices)

A This setting will be applied to the 10 device under the group. Are you sure to apply it?

Automatic switch mode

.On

EveryDay © | 09 00 o 20 00

u It will autc ically restart 5 mi before the screen is turned on.

Cancel
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5. Check the box if you want the device to automatically restart five minutes before the screen is
turned on. If you don’t want the automatic restart, uncheck the box. Click apply.

Screen Settings (All devices)

A This setting will be applied to the 10 device under the group. Are you sure to apply it?

Automatic switch mode

.On

EveryDay @ & 09 00 @ 20 00

u It will automatically restart 5 minutes before the screen is turned on.
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APl & Dynamic content

Creating an API template using the designed template

I. In X-Sign Designer, click on the icon Fg to go to the template page.

File Edit Insert Arrange View Preview Delivery Video Wall Help
* .

Edit mode . [ Preview Save v @ joy123

New Page (1)

Video Rectangle

(ORI

oval Line
Property -
Page =
Name New Page (1)
Duration 00:10:00
Resolution 1920x1080 Modify
1920 x 1080 X:-339 Y:131 - + 37% - Panel Area 1x1

2. Click on the API template to open the designed template.

%) X-Sign Designer - C:\Users\user\Documents\UM\scene.xml *

File Edit Insert Arrange View Preview PENY Video Wall Help
' f

API-Template-Restaurant 1920x1080 [ preview Save ~

A/
PREMIUM
Player Only

Template 0

5

API template -

)
B]

odefaultMediaName (Widget)

Steak Hou &l

© defaultMediaName (Widget)
Chilled & Australian . - © defaultMediaName (Widget)
1920x1080 L GranFed o D S ® T defaultMediaName (Text Slideshow)
Tenderloin (7 B -
Bank = T Bone (240z/7 3 E 3 < i ® T defaultMediaName (Text Slideshow)

Rib-Eye (100z / 3

© T: defaultMediaName (Text Slideshow)

[

= . A ® T: defaultMediaName (Text Slideshow;
BankA | AllTime ¢ )
1920x1080 1920x1080 ’ ) Favourite A 6 dofaibhadiaN oo (leaaoo)

Bank-A Bank-B
Bar . Hungarian Beef Goulash Property -
Blue Cheese Burger >

Beef Stroganoof Tor -

Boutique = Western Burger Daytona d
Ossobucco Gemolata
Beach Wings N hoken N Name \PI-Template-Restaurant 1920x1080
A Duration 00:10:00

Handbag Sto.. Handbag Sto...
1920x1080 1920x1080 Resolution 1920x1080 Modify

m%{ 1920 x 1080 X:269 Y:755 - + 37% -~ Panel Area 1x1

3. You can click on the template to import new images. You can also edit the designed template in
the editing area on the right panel. See Encrypting a project in X-Sign Designer on page 87.
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Creating a dynamic content widget

By syncing your database and setting conditions, X-Sign can display real-time dynamic information
automatically.

Note: Make sure you've connected your database to X-Sign via X-Sign Open API.

I. In X-Sign Designer, select the widget tab and click Dynamic content to add a widget.

% X-Sign Designer - C:\Users\user\Documents\UM\scenexml

File Edit Insert Arrange View Preview Delivery Video Wall Help
¥

¥ Edit mode . : - .
New Page (1) [®] Preview Save @ joy123

s [£]

Basic Tools

Text Image
Video Rectangle
Oval Line

Page v
Name New Page (1)
Duration 00:10:00
Resolution 1920x1080 Modify
1920 x 1080 X:339  Y:-131 -+ 37 - 3 Panel Area 1x1

2. Select a database from the list.

Room location

Promotion and Inventory

Select your database
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3. Modify the datatype to ensure each source is recognized correctly.

Database: Promotion and Inventory -

4

- A price EERT Text ~
@ price_diseount m5€ Text =
@ productintre_DE Detush detall info 007 Taxt v
@, productintro_EN English detail info 007 Ted ~ m

nsplash.com/photo-11 Te

280273421 7ixlib]

B, product_image =12
uto=formatAfit=croplu=T1440=80

q Product.namo.p

: Today's Special_DE

@ product risme €

u Today's Special

A productuuld a7 Text >

Selected Keys:

4. Click Select to add datatype to the list below and click Import to add contents to your
template.

Database: Promotion and Inventory -

Q price 135€ AR sclect

Q,  price_discount W€ A select

Q,  preductintro_DE Detush detail info 007 AR sclect

Q,  productintro_EN English detail info 007 LRl Select
pse/ i unsplash, oh 7 bbi2802
& poscimp | [l reranm e wmpsmasmacsonn (o] [ NN
fit=crophw=T744g=80
roduct_name_D
Q : S Today's Special_DE 1T select
roduct_name_E
Q : i Today's Special ARl select
Q, preductuuid 007 A select

Selected Keys: /0

3
e

B product_image T price T product_nam-
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Setting conditions to your template for different scenarios

Note: Make sure you’ve connected your database to X-Sign via X-Sign Open API.

In X-Sign Designer, you can set up conditions in order to show certain texts or images in a certain
scenario. For example, you want the menu to show a “sold out” icon once the quantity of a menu

item equals zero. To do so, follow the steps below:

I. Use tools on the left column to create texts or images you want to show under certain circum-

stances. E.g. a “sold out” icon.

File  Edit Insert Arange View  Preview  Delivery VideoWall Help
i .

New Page (2) - Sy e ] Preview Sve v @ doku Chen

Ben's 2F Restaurant

Click the "+" button to add conditions

BBQ Glazed Ribs
Half Rack

SOLD OUT §

19201080 X586 Y--L1B s -

2. Click the Condition tab on the right side, and click “+” to add conditions.

File  Edit Insert Amonge View  Preview  Delivery VideoWall Help
5 .

New Page (2} - s - [B] Prevew Save = @ okuchen

Ben's 2F Restaurant

Click the "+" button to add conditions

BBQ Glazed Ribs
Half Rack

SOLD oUT

1920x1080  X:1586  Y:-lB
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3. Set up the conditions. For example, if the Reference value “inventory status” = 0, then show
the “sold out” icon on the menu.

Edit condition

A Condition Show sold outicon

I

Reference value  inventory_status Bl Modify |
C| conion = .

0

Show below objects

i 002 sold out icon (Group)

D | CEED |e==

E Confirm Cancel

A. Name the Condition.

B. Click Modify to choose a datatype from your database in order to set up reference value.
C. Select the logic and key in the condition.

D. Click Add to select the object you created at step |.

E. Click Confirm to finish the condition settings.

4. To manage your condition list:

* Hover over the bar and click the icon to edit or delete the condition.

Design Condition
Condition List +
(L2 @D |

* Click to turn the condition on/off.

Design Condition
Condition List +

Show sold out icon ‘
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GPL/LGPL Software Licenses Used by X-Sign

X-Sign Player for Android is a commercial app that contains LGPL libs, including:

* [Qt] https://www.qt.io/download for Android

* [FFmpeg] https://www.ffmpeg.org/

* [KArchive] https://github.com/KDE/karchive

* [libgrencode] https://github.com/fukuchi/libqrencode

* Android player 2.6.6.1 LGPL release:
https://cmota.s3-ap-northeast- | .amazonaws.com/XSIGN_LGPL/XSignPlayer-Igpl-android-arm-
2.6.6.1.zip

* Qt 5.12.7 source code release:
https://cmota.s3-ap-northeast- | .amazonaws.com/XSIGN_LGPL/qt-android-arm.zip

X-Sign Player is created by using statically-linked library for better performance and compatibility.

In order to meet LGPL requirement, these Packages are provided to allow user to rebuild X-Sign
Player apk with modified LGPL libs. By downloading and using the Packages, you are acknowledging
and accepting all risk and liability associated with the usage of the Packages, as well as agreeing to
comply with the GPL/LGPL included with each Package.

Disclaimer:

BENQ PROVIDES THE PACKAGES AND THIS DOWNLOAD SERVICE "AS IS" WITHOUT
WARRANTY OF ANY KIND AND ALL SUCH WARRANTIES, EXPRESS OR IMPLIED, ARE
HEREBY DISCLAIMED, INCLUDING, WITHOUT LIMITATION, WARRANTIES OF
MERCHANTABILITY, FITNESS OR USEFULLNESS FOR ANY PARTICULAR PURPOSE,
ACCURACY, AVAILABILITY, QUALITY OF THE PACKAGES, PERFORMANCE OR NON-
INFRINGEMENT. BENQ does not provide nor is obligated to provide support for the usage of the
Packages. BENQ is not responsible for any copyright or trademark infringement.
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